WF-2830 User's Guide
## Contents

### WF-2830 User's Guide

- **Product Basics** .......................................................................................................................... 14
  - Product Parts Locations ............................................................................................................. 14
  - Product Parts - Front and Top ................................................................................................. 15
  - Product Parts - Inside ............................................................................................................... 16
  - Product Parts - Back .................................................................................................................. 18
- Using the Control Panel ................................................................................................................... 18
  - Control Panel Buttons and Lights ............................................................................................... 19
  - Adjusting Control Panel Position ............................................................................................. 20
  - The LCD Screen ....................................................................................................................... 21
  - Status Icon Information ............................................................................................................. 21
  - Entering Characters on the LCD Screen .................................................................................... 22
  - Selecting the Date and Time ...................................................................................................... 22
  - Changing LCD Screen Language ............................................................................................... 23
  - Adjusting Control Panel Sounds ............................................................................................... 24
  - Preventing PC Connection via USB ........................................................................................... 25
- Using Power Saving Settings ............................................................................................................ 26
  - Changing the Sleep Timer Settings ........................................................................................... 26
  - Changing the Power Off Timer Settings .................................................................................... 26
- Epson Connect Solutions for Smartphones, Tablets, and More .................................................... 27
  - Setting Up Epson Connect Services .......................................................................................... 28
  - Using Epson Email Print ............................................................................................................ 28
  - Using the Epson iPrint Mobile App ............................................................................................ 29
  - Using Epson Remote Print .......................................................................................................... 29
  - Voice-activated Printing .............................................................................................................. 30
- Using AirPrint .................................................................................................................................. 31
- Using Google Cloud Print ............................................................................................................... 31
  - Setting Up Google Cloud Print on a Chromebook ........................................................................ 32
- Android Printing Using the Epson Print Enabler ............................................................................ 33
- Using Fire OS Printing .................................................................................................................... 34
Using Windows 10 Mobile Printing .................................................................................................... 34
Using Epson Print and Scan App with Windows Tablets ................................................................. 35

**Wi-Fi or Wired Networking** ........................................................................................................ 36

- Network Security Recommendations ................................................................................................. 36
- Wi-Fi Infrastructure Mode Setup ....................................................................................................... 37
  - Selecting Wireless Network Settings from the Control Panel ......................................................... 38
- Wi-Fi Direct Mode Setup ...................................................................................................................... 40
  - Enabling Wi-Fi Direct Mode ............................................................................................................. 40
- Wi-Fi Protected Setup (WPS) .............................................................................................................. 42
  - Using WPS to Connect to a Network ............................................................................................... 42
- Printing a Network Status Sheet ........................................................................................................ 43
- Printing a Network Connection Report ............................................................................................. 44
- Network Connection Report Codes and Messages .............................................................................. 45
- Changing or Updating Network Connections .................................................................................... 51
  - Accessing the Web Config Utility .................................................................................................... 51
  - Changing a USB Connection to a Wi-Fi Connection ..................................................................... 52
  - Changing a Wi-Fi Connection to a Wired Network Connection .................................................. 52
  - Connecting to a New Wi-Fi Router ................................................................................................. 53
  - Disabling Wi-Fi Features ................................................................................................................. 53

**Loading Paper** ................................................................................................................................ 55

- Loading Paper in the Rear Feed ......................................................................................................... 55
  - Paper Loading Capacity ...................................................................................................................... 59
  - Double-sided Printing Capacity ....................................................................................................... 59
  - Borderless Paper Type Compatibility ............................................................................................... 60
- Compatible Epson Papers .................................................................................................................. 61
- Paper or Media Type Settings - Printing Software ........................................................................... 63
- Selecting the Paper Settings for Each Source - Control Panel ....................................................... 63
  - Paper Type Settings - Control Panel ............................................................................................... 64
- Selecting the Default Paper Source Settings ................................................................................... 65
  - Paper Source Settings Options ........................................................................................................ 66

**Placing Originals on the Product** .................................................................................................. 67

- Placing Originals on the Scanner Glass ............................................................................................. 67
- Placing Originals in the Automatic Document Feeder ....................................................................... 68
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting Double-sided Printing Settings - Mac</td>
<td>112</td>
</tr>
<tr>
<td>Double-sided Printing Options and Adjustments - Mac</td>
<td>113</td>
</tr>
<tr>
<td>Managing Color - Mac</td>
<td>114</td>
</tr>
<tr>
<td>Color Matching and Color Options - Mac</td>
<td>115</td>
</tr>
<tr>
<td>Selecting Printing Preferences - Mac</td>
<td>116</td>
</tr>
<tr>
<td>Printing Preferences - Mac</td>
<td>117</td>
</tr>
<tr>
<td>Printing Your Document or Photo - Mac</td>
<td>117</td>
</tr>
<tr>
<td>Checking Print Status - Mac</td>
<td>118</td>
</tr>
<tr>
<td>Printing From a Chromebook</td>
<td>119</td>
</tr>
<tr>
<td>Cancelling Printing Using a Product Button</td>
<td>120</td>
</tr>
<tr>
<td><strong>Scanning</strong></td>
<td>121</td>
</tr>
<tr>
<td>Starting a Scan</td>
<td>121</td>
</tr>
<tr>
<td>Starting a Scan Using the Product Control Panel</td>
<td>121</td>
</tr>
<tr>
<td>Setting up a WSD Port (Windows 7/Windows Vista)</td>
<td>123</td>
</tr>
<tr>
<td>Changing Default Scan Job Settings</td>
<td>124</td>
</tr>
<tr>
<td>Starting a Scan Using the Epson Scan 2 Icon</td>
<td>124</td>
</tr>
<tr>
<td>Starting a Scan from a Scanning Program</td>
<td>127</td>
</tr>
<tr>
<td>Starting a Scan from a Smart Device</td>
<td>129</td>
</tr>
<tr>
<td>Scanning in Epson Scan 2</td>
<td>129</td>
</tr>
<tr>
<td>Additional Scanning Settings - Main Settings Tab</td>
<td>132</td>
</tr>
<tr>
<td>Additional Scanning Settings - Advanced Settings Tab</td>
<td>132</td>
</tr>
<tr>
<td>Saving Scanned Documents as a Searchable PDF Using Epson Scan 2</td>
<td>134</td>
</tr>
<tr>
<td>Image Format Options</td>
<td>135</td>
</tr>
<tr>
<td>Scan Resolution Guidelines</td>
<td>136</td>
</tr>
<tr>
<td><strong>Faxing</strong></td>
<td>137</td>
</tr>
<tr>
<td>Connecting a Telephone or Answering Machine</td>
<td>137</td>
</tr>
<tr>
<td>Setting Up Fax Features</td>
<td>140</td>
</tr>
<tr>
<td>Setting Up Basic Fax Features</td>
<td>141</td>
</tr>
<tr>
<td>Using the Fax Setup Wizard</td>
<td>141</td>
</tr>
<tr>
<td>Selecting the Line Type</td>
<td>143</td>
</tr>
<tr>
<td>Setting the Number of Rings to Answer</td>
<td>144</td>
</tr>
<tr>
<td>Selecting Advanced Fax Settings</td>
<td>144</td>
</tr>
<tr>
<td>Basic Settings - Fax</td>
<td>145</td>
</tr>
</tbody>
</table>
Welcome to the WF-2830 User's Guide.
For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

Product Parts Locations
Using the Control Panel
Using Power Saving Settings
Epson Connect Solutions for Smartphones, Tablets, and More
Voice-activated Printing
Using AirPrint
Using Google Cloud Print
Android Printing Using the Epson Print Enabler
Using Fire OS Printing
Using Windows 10 Mobile Printing
Using Epson Print and Scan App with Windows Tablets

Product Parts Locations
See these sections to identify the parts on your product.

Product Parts - Front and Top
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
Product Parts - Front and Top

1 Automatic Document Feeder (ADF) cover
2 ADF input tray
3 ADF edge guide
4 ADF document support
5 ADF output tray

1 Rear paper feed
2 Rear feed paper support
3 Rear feed edge guides
4 Output tray
5 Paper stopper

Parent topic: Product Parts Locations

Product Parts - Inside

1 Document cover
2 Scanner glass
3 Control panel

1 Scanner unit support
2 Scanner unit
3 Ink cartridge holder (do not remove)

Parent topic: Product Parts Locations
Product Parts - Back

1  Maintenance box cover
2  Rear cover
3  AC inlet
4  EXT port
5  LINE port
6  USB port

Parent topic: Product Parts Locations

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights
Adjusting Control Panel Position
The LCD Screen
Status Icon Information
Entering Characters on the LCD Screen
Control Panel Buttons and Lights

1. 💡 power button and light
2. LCD screen
3. 📋 help button
4. Arrow buttons and **OK** button
5. ❌ cancel button
6. Keypad
7. 📋 clear button
8. 🔍 start button
9  🔄 reset button
10  👈 back button
11  ☄️ received fax light
12  🏠 home button

Parent topic: Using the Control Panel

Adjusting Control Panel Position

You can adjust the position of the control panel to make it easier to access. Raise or lower it to the desired angle as shown.

Parent topic: Using the Control Panel
The LCD Screen

1 Displays various status information; select an icon to check its status or adjust its settings
2 Scroll right (or left) by pressing the arrow buttons
3 Menu options
4 Displays available button actions

Parent topic: Using the Control Panel

Status Icon Information

Your product displays status icons on the LCD screen for certain product status conditions.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>No Wi-Fi connection.</td>
</tr>
<tr>
<td>🌐</td>
<td>A Wi-Fi network error has occurred or the product is searching for a connection.</td>
</tr>
<tr>
<td>🌐</td>
<td>A Wi-Fi connection is established. The number of bars indicates the connection's signal strength.</td>
</tr>
<tr>
<td>🌐</td>
<td>No Wi-Fi Direct connection.</td>
</tr>
<tr>
<td>🌐</td>
<td>A Wi-Fi Direct connection is established.</td>
</tr>
</tbody>
</table>

Parent topic: Using the Control Panel
Entering Characters on the LCD Screen

1. Moves the cursor left or right
2. Switches display between uppercase and lowercase letters, numbers, or symbols
3. Enters a space
4. Deletes the previous character
5. Select when you are done entering your password

Parent topic: Using the Control Panel

Selecting the Date and Time

Before faxing, select the current date, time, and daylight saving phase in your area, and choose your preferred date and time format.

1. Press the \( \Rightarrow \) home button, if necessary.
2. Select Settings > Printer Setup > Date/Time Settings.
You see a screen like this:

3. Select **Daylight Saving Time**.
4. Select the setting that applies to your area:
   - **Winter**: it is winter or your region does not use Daylight Saving Time (DST)
   - **Summer**: it is spring or summer and your region uses Daylight Saving Time (DST)

   **Note**: If your region uses Daylight Saving Time (DST), you must change this setting to match the season. When you change from **Winter** to **Summer**, your product automatically sets its clock ahead one hour. When you change from **Summer** to **Winter**, it sets its clock back one hour.

5. Select **Date/Time**.
6. Select the date format you want to use.
7. Use the numeric keypad to enter the current date. Press the **OK** button when finished.
8. Select the time format you want to use.
9. Use the numeric keypad to enter the current time. Press the **OK** button when finished.
10. Press the home button to exit.

**Parent topic**: Using the Control Panel

### Changing LCD Screen Language

You can change the language used on the LCD screen.

1. Press the home button, if necessary.
2. Select **Settings > Printer Setup > Language**.
   You see a screen like this:

   ![Language settings screen]

3. Select a language.

   **Parent topic:** Using the Control Panel

**Adjusting Control Panel Sounds**

You can adjust the sound level heard when you press buttons on the control panel.

1. Press the home button, if necessary.
2. Select **Settings > Printer Setup > Sound**.
   You see a screen like this:

   ![Sound settings screen]

   ![Mute sound level]

   ![1 / 3 sound level]
3. Select **Mute**, **Normal Mode** or **Quiet Mode**.

4. If you selected **Normal Mode** or **Quiet Mode**, do the following:
   - Select **Button Press**.
   - Press the arrow buttons to decrease or increase the sound.
   - Press the **OK** button when you are done.

**Parent topic:** Using the Control Panel

### Preventing PC Connection via USB

You can disable access from a USB-connected computer. This restricts non-network access to the product and protects the security of confidential scanned documents.

1. Press the home button, if necessary.
2. Select **Settings > Printer Setup > PC Connection via USB**.
   
   You see a screen like this:

   ![PC Connection via USB screen](image)

3. Select **Disable**.

   **Note:** You need to restart the printer to enable the setting. Select **Yes**.

**Parent topic:** Using the Control Panel
Using Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Sleep Timer Settings
Changing the Power Off Timer Settings
Parent topic: Product Basics

Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

1. Press the home button, if necessary.
2. Select Settings > Printer Setup > Sleep Timer.
   You see a screen like this:

   ![Sleep Timer screenshot]

   3. Use the keypad to enter the number of minutes and press the OK button when you are done.

Parent topic: Using Power Saving Settings

Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

1. Press the home button, if necessary.
2. Select Settings > Printer Setup > Power Off Timer.
You see a screen like this:

3. Select a time period, or select Off.

Parent topic: Using Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages from your home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Print from anywhere with these Epson Connect solutions:

- Epson Email Print
- Epson iPrint Mobile App
- Epson Remote Print

Scan and send a file as an email or upload it to an online service directly from your Epson product with the Epson iPrint Mobile App.

Setting Up Epson Connect Services
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Parent topic: Product Basics

Setting Up Epson Connect Services
If you did not activate your product's email address for use with Epson Connect when you set up your product, you can activate it using the product control panel.

1. Press the home button, if necessary.
2. Select Settings > Epson Connect Services > Register/Delete.
   You see a screen like this:

![Register your printer to Epson Connect services?](image)

3. Press the OK button and follow the on-screen instructions to activate your product's email address.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the attachments will print automatically.

1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below to use your product control panel to activate your unique email address. Or visit epson.com/connect (U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email Print, create your Epson Connect account, and register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

   **Note:** Go to epsonconnect.com and log into your Epson Connect account to personalize your product's email, adjust print settings, and set up other Epson Connect services.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

---

### Using the Epson iPrint Mobile App

Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can scan and save a file on your device, send it as an email, or upload it to an online service such as Box, Dropbox, Evernote, or Google Drive.

1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print or scan with your mobile device and your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

---

### Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

   **Note:** Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print Driver software.
4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer application and choose the Remote Print option for your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

**Voice-activated Printing**

Take advantage of voice-activated, hands-free printing from your Epson product with Alexa, Siri, and Google Assistant. Depending on which voice assistant you use, you can ask your product to print photos, calendars, recipes, photo props, and more. [Click here](#) for more information.

1. Connect your product to your network. See the link below.
2. Do one of the following:
   - Alexa or Google Assistant: Set up your product's email address for use with Epson Connect. See the link below to activate it from the product control panel.
   - Siri: Download and install the Epson iPrint app then select your product. See the link below for instructions.
3. [Click here](#) for instructions on how to set up your product and voice assistant to use the voice-activated printing feature.

Now you are ready to print with your voice and your Epson product.

**Parent topic:** Product Basics

**Related tasks**

Setting Up Epson Connect Services
Using the Epson iPrint Mobile App
Related topics
Wi-Fi or Wired Networking

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and Mac with the latest version of OS X or macOS.

Note: If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
Related references
Paper Source Settings Options

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Note your product’s IP address by checking your network status. See the link below.
3. Connect your computer or your mobile device to the same wireless network as your Epson product.
4. Enter your product's IP address into the address bar of a web browser.
5. Select the **Google Cloud Print Services** option.

   **Note:** If you don't see the **Google Cloud Print Services** option, turn your product off and back on. If the option still doesn't appear, select the **Firmware Update** option and follow the on-screen instructions to update your product.

6. Click **Register**.
7. Select the checkbox to agree to the Usage Advisory and click **Next**.
8. Click **OK** to launch the sign-in page.
   A separate browser window opens.
9. Enter your Google Account username and password and click **Sign in**, or, if you don't have an account, click **Sign up for a new Google Account** and follow the on-screen instructions.
10. Click **Finish printer registration** to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, computer, Apple or Android device with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

**Setting Up Google Cloud Print on a Chromebook**

**Parent topic:** Product Basics

**Related tasks**

- Printing From a Chromebook

**Related topics**

- Wi-Fi or Wired Networking

---

**Setting Up Google Cloud Print on a Chromebook**

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

   **Note:** See your Chromebook's documentation for details on connecting to a network.
3. Do one of the following:
   • Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.

   **Note:** If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click **Add to Cloud Print**.

   • Open a web browser and enter `chrome://devices` in the address bar. Skip to step 5.
   • If you see a registration confirmation screen instead, click **Register**.

4. Click **Add Device**.

5. Click the **Register** button that appears next to your product.

6. Click **Register** on the confirmation screen. Your product's LCD screen displays a confirmation message.

7. Select **OK** or press the **OK** button on your product to confirm the Google Cloud Print connection and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone, or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

**Parent topic:** Using Google Cloud Print

**Related topics**

Wi-Fi or Wired Networking

---

**Android Printing Using the Epson Print Enabler**

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson product and print.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to **Settings** on your Android device, select **Printing**, and enable the Epson plug-in.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and print whatever is on the screen.

   **Note:** If you do not see your product, tap **All Printers** and select your product.

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

---

**Using Fire OS Printing**

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. With just a few taps in Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your product to print whatever is on the screen.

   **Note:** If you see a message telling you that a plug-in is required, tap **OK** and tap **Download**. If your Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria Print Service app to print.

**Parent topic:** Product Basics

**Related topics**

Wi-Fi or Wired Networking

---

**Using Windows 10 Mobile Printing**

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. Look for the print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your product to print whatever is on the screen.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Epson Print and Scan App with Windows Tablets

You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface RT or Pro tablet with networked Epson products. Epson Print and Scan App allows you to scan and capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan App does not support Windows 10 Mobile printing.

1. Connect your Epson product to your wireless network. See the link below.
2. Download Epson Print and Scan App from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open Epson Print and Scan App and select your Epson product.
   Now you are ready to print photos or scan.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Network Security Recommendations
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• **Enable security on your wireless LAN**
  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• **Connect your product only to a network protected by a firewall**
  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• **Change the default administrator password on your product**
  If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel

Parent topic: Wi-Fi or Wired Networking
Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install the necessary software by downloading it from the Epson website. The installer program guides you through network setup.

**Note:** Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.
   
   You see a screen like this:

   ![Network settings screen](image)

   3. Select Wi-Fi (Recommended).
4. Press the OK button to proceed.
5. Select Wi-Fi Setup Wizard.
6. Select the name of your wireless network or select Other SSIDs to enter the name manually. Use the displayed keypad to enter your network name.
7. Enter your wireless password.

![Enter Password](image)

**Note:** The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

8. Select **OK** when you finish entering your password.

9. If you want to print a network setup report, press the ▼ start button. (Otherwise, press the ◄ cancel button.)

10. Press the ◄ home button to exit, if necessary.

   You see the 📰 icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software as described on the *Start Here* sheet.

**Parent topic:** Wi-Fi Infrastructure Mode Setup

**Related references**

- Status Icon Information
- Entering Characters on the LCD Screen
**Wi-Fi Direct Mode Setup**

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network access point for up to 8 devices.

1. Epson product
2. Computer with a wireless interface
3. Other wireless device

**Enabling Wi-Fi Direct Mode**

**Parent topic:** Wi-Fi or Wired Networking

**Enabling Wi-Fi Direct Mode**

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.
You see a screen like this:

3. Select **Wi-Fi Direct**.
4. Press the **OK** button twice to proceed.

You see a screen like this:

5. Do one of the following:
   • For iOS devices, select **iOS**. Press the **OK** button to view and scan the QR code with the camera app on your device, then follow the instructions on your device. Press the **OK** button, then press the down arrow button to scroll down and display the product information. Open the Epson iPrint app on your device and select your product. Press the **OK** button to return to the home screen.

   **Note:** You can also select **Other Methods** to view the product's network name and password.
• For Android devices, select **Android**. Open the Epson iPrint app on your device and select your product. Press the down arrow button to scroll down and display the product information. Press the **OK** button to return to the home screen.

• For other types of devices, select **Other OS Devices**. Press the down arrow button to scroll down and display the product information. On your device, select the Wi-Fi network name (SSID) displayed on the LCD screen and enter the password shown. Press the **OK** button to return to the home screen.

The Wi-Fi Direct icon is displayed on the LCD screen and indicates if Wi-Fi Direct is enabled on the product.

**Parent topic:** Wi-Fi Direct Mode Setup

**Related references**

Status Icon Information

---

**Wi-Fi Protected Setup (WPS)**

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled **WPS** on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

**Using WPS to Connect to a Network**

**Parent topic:** Wi-Fi or Wired Networking

---

**Using WPS to Connect to a Network**

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the home button, if necessary.
2. Select **Wi-Fi Setup**.
You see a screen like this:

3. Select **Wi-Fi (Recommended)**.
4. Select **Push Button Setup (WPS)**.
5. Follow the instructions on the LCD screen to complete WPS setup.
6. Press the home button to exit.

   You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print. If you are printing from a computer, make sure you installed the network software as described on the *Start Here* sheet.

   **Note:** If you don’t see the icon, repeat these steps to try again.

**Parent topic:** Wi-Fi Protected Setup (WPS)

**Related references**

- Status Icon Information

### Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

1. Make sure a few sheets of plain paper are loaded in the product.
2. Press the home button, if necessary.
3. Select **Settings > Network Settings > Print Status Sheet**.
You see a screen like this:

![Screen with options: Yes, No]

1. Press the start button to print the status sheet.
2. Examine the settings shown on the network status sheet to diagnose any problems you have.

**Parent topic:**  Wi-Fi or Wired Networking

---

## Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your product on a network.

1. Make sure a few sheets of plain paper are loaded in the product.
2. Press the home button, if necessary.
3. Select **Settings > Network Settings > Connection Check**.
After the network connection is checked, you see a screen like this:

4. Press the start button to print the report.
Examine the error codes and solutions shown on the network connection report.

Network Connection Report Codes and Messages
Parent topic: Wi-Fi or Wired Networking

Network Connection Report Codes and Messages
Check the error codes and messages on the network connection report to solve problems you may encounter with network connections. The tables here list solutions to problems based on the error codes and messages that may appear on the top of the report.
Error Codes and Messages

<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1</td>
<td>Make sure your router, access point, and/or hub are turned on, and the network cable is securely connected to your device and to your product. If you are trying to set up Wi-Fi, remove the network cable and set up Wi-Fi again. Ethernet and Wi-Fi cannot be connected at the same time.</td>
</tr>
</tbody>
</table>

Note: Error codes and messages listed here may not all apply to your product.
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E2, E3, or E7</strong></td>
<td>Check the following:</td>
</tr>
<tr>
<td>No wireless network names (SSID) found. Confirm that the router/access point is turned on and the wireless network (SSID) is set up correctly. Contact your network administrator for assistance.</td>
<td>• Make sure your router or access point is turned on, and is correctly connected to your computer or network device.</td>
</tr>
<tr>
<td>No wireless network names (SSID) found. Confirm that the wireless network name (SSID) of the PC you wish to connect is set up correctly. Contact your network administrator for assistance.</td>
<td>• Turn off the router or access point, wait about 10 seconds, and turn it on again.</td>
</tr>
<tr>
<td>Entered security key/password does not match the one set for your router/access point. Confirm security key/password. Contact your network administrator for assistance.</td>
<td>• Move your product closer to your router or access point, and remove any obstacles between them. Also move your product away from devices such as wireless phones or microwaves.</td>
</tr>
<tr>
<td>• Confirm that the SSID shown on the network connection report matches the label on your router or access point. Also make sure your SSID uses only ASCII characters and symbols, or your product cannot display the SSID correctly.</td>
<td>• If you are trying to connect using the WPS push button method, make sure your router or access point supports it.</td>
</tr>
<tr>
<td>• If you are using a network password, check the label on your router or access point to confirm that you are using the correct password, or check with your network administrator or router/access point documentation.</td>
<td>• If you are connecting to a smart device that generates an SSID, check the device documentation for the SSID and password you should use.</td>
</tr>
<tr>
<td>• If your wireless connection suddenly disconnects, and another smart device was added to the network using a WPS push button method or your network was set up using a non-WPS push button method, try downloading and installing your product software again.</td>
<td>• If your wireless connection suddenly disconnects, and another smart device was added to the network using a WPS push button method or your network was set up using a non-WPS push button method, try downloading and installing your product software again.</td>
</tr>
<tr>
<td>Error code and message</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>E5</strong></td>
<td>If the security on your router or access point is not one of the following types, change the type of security on your router or access point and reset your product’s network settings.</td>
</tr>
</tbody>
</table>
| Security mode (e.g. WEP, WPA) does not match the current setting of the printer. Confirm security mode. Contact your network administrator for assistance. | • WEP-64 bit (40 bit)  
• WEP-128 bit (104 bit)  
• WPA PSK (TKIP/AES); also known as WPA Personal  
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal  
• WPA (TKIP/AES)  
• WPA2 (TKIP/AES)  
Also make sure you are connecting to the 2.4GHz band on your network and using the password for that band. |
| **E6**                 | If your router or access point has MAC address filtering enabled, register your product’s MAC address so it is not filtered. Locate the MAC address on the network connection report and check your router or access point documentation for instructions. |
| MAC address of your printer may be filtered. Check whether your router/access point has restrictions such as MAC address filtering. See the documentation of the router/access point or contact your network administrator for assistance. | If your router or access point is using shared authentication with WEP security, confirm that you are using the correct authentication key and index.  
If your router or access point limits the number of connected devices, raise the connection limit. See your router or access point documentation for instructions. |
<p>| <strong>E8</strong>                 | If your product’s Obtain IP Address setting is set to Auto, enable DHCP on your router or access point. If it is set to Manual, the IP address may be out of range or on a different network segment; set a valid IP address using your product control panel or the Web Config utility. You can also try turning off your product and the router or access point, waiting about 10 seconds, and turning them on again. |
| Incorrect IP address is assigned to the printer. Confirm IP address setup of the network device (hub, router, or access point). Contact your network administrator for assistance. | |</p>
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
</table>
| **E9**                 | Make sure your computer or network device are turned on. Also make sure that you can access the internet and other devices on the same network from the devices you are trying to connect to your product.  
If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. Download and install your product software again to reset your network settings. |
| Confirm the connection and network setup of the PC or other device. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. | |
| **E10**                | Make sure other devices on the network are turned on and do the following:  
- If your product's Obtain IP Address setting is set to Manual, check the IP address, subnet mask, and default gateway addresses on the network connection report to see if they are correct. If not, correct the settings.  
- If DHCP is enabled, set your product's Obtain IP Address setting to Auto. If you want to use the DHCP-assigned address as a static address, set the Obtain IP Address setting to Manual, enter the product's IP address as listed on the network connection report, and set the subnet mask to 255.255.255.0.  
If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. |
<p>| Confirm IP address, subnet mask, and default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. | |
| <strong>E11</strong>                | If you set your product's TCP/IP Setup setting to Manual, check that the default gateway address listed on the network connection report is correct. Also turn on the device that is set as the default gateway. |
| Setup is incomplete. Confirm default gateway setup. Connection using the EpsonNet Setup is available. Contact your network administrator for assistance. | |</p>
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E12</strong>&lt;br&gt;Confirm the following&lt;br&gt;-Entered security key/password is correct&lt;br&gt;-Index of the security key/password is set to the first number&lt;br&gt;-IP address, subnet mask, or default gateway setup is correct&lt;br&gt;Contact your network administrator for assistance.</td>
<td>Make sure other devices on the network are turned on and do the following:&lt;br&gt;• Make sure the IP address, subnet mask, and default gateway addresses are correct, if you are entering them manually.&lt;br&gt;• Confirm that the subnet mask and default gateway addresses for other devices are the same.&lt;br&gt;• Make sure the IP address does not conflict with other devices.&lt;br&gt;If you still cannot connect to your product, do the following:&lt;br&gt;• Turn off your router or access point, wait about 10 seconds, and turn it on again.&lt;br&gt;• Download and install your product software again to reset your network settings.&lt;br&gt;• If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product.</td>
</tr>
<tr>
<td><strong>E13</strong>&lt;br&gt;Confirm the following&lt;br&gt;-Entered security key/password is correct&lt;br&gt;-Index of the security key/password is set to the first number&lt;br&gt;-Connection and network setup of the PC or other device is correct&lt;br&gt;Contact your network administrator for assistance.</td>
<td>Make sure your router, access point, and/or hub are turned on. Also make sure the TCP/IP setup on your router, access point, and/or hub is not set manually; this may cause your product's network settings to differ from the manually set up devices.&lt;br&gt;If you still cannot connect to your product, do the following:&lt;br&gt;• Turn off your router or access point, wait about 10 seconds, and turn it on again.&lt;br&gt;• Download and install your product software again to reset your network settings.&lt;br&gt;• If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product.</td>
</tr>
</tbody>
</table>
Network Environment Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wi-Fi environment needs to be improved. Turn the wireless router off</td>
<td>Move your product closer to your router or access point, and remove any obstacles between them. Then turn off your router or access point, wait about 10 seconds, and turn it back on again. If you still cannot connect to your product, check the documentation that came with your router or access point for solutions.</td>
</tr>
<tr>
<td>then turn it on. If the connection does not improve, see the documentation for the wireless router.</td>
<td></td>
</tr>
<tr>
<td>*No more devices can be connected. Disconnect one of the connected devices if you want to add another one.</td>
<td>You can connect up to 8 computers or other devices to your product using a Wi-Fi Direct (Simple AP) connection. If you want to add another device, disconnect an existing connected device first.</td>
</tr>
<tr>
<td>The same SSID as Wi-Fi Direct exists in the environment. Change the Wi-Fi Direct SSID if you cannot connect a smart device to the printer.</td>
<td>Change the Wi-Fi Direct SSID.</td>
</tr>
</tbody>
</table>

Parent topic: Printing a Network Connection Report

Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser. You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar. You see the available Web Config utility options.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

- Printing a Network Status Sheet

---

**Changing a USB Connection to a Wi-Fi Connection**

If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

**Parent topic:** Changing or Updating Network Connections

**Related concepts**

- Uninstall Your Product Software

---

**Changing a Wi-Fi Connection to a Wired Network Connection**

If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select **Wired network connection**.
8. If you see a Select Setup Option screen, select **Set up printer for the first time**.
9. Continue following the rest of the on-screen instructions.
Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
   - **Windows**: Uninstall your product software.
   - **Mac**: Go to the next step.
2. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.

**Note:** Before disabling Wi-Fi features, make a note of your product's SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.
2. Select **Wi-Fi Setup**.
You see a screen like this:

3. Select **Wi-Fi (Recommended)** > **Others** > **Disable Wi-Fi** > **Start Setup** to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in the Rear Feed
Compatible Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Source Settings

Loading Paper in the Rear Feed

You can load plain paper in the rear feed up to the line indicated by the triangle mark inside the edge guides. For loading other paper types, see the link below.

**Note:** Before loading paper, make sure your product is not currently printing, faxing, scanning, or copying.

1. Pull out the rear paper feed support.
2. Slide the edge guides outward.

3. Do one of the following:
   • Load paper at the center of the rear feed with the glossy or printable side facing up.
   • Insert up to 10 envelopes short edge first with the printable side facing up.
• Load one sheet of loose-leaf or other paper with holes as shown.

[Image of paper饲示]

**Note:** Do not select automatic 2-sided printing for this type of paper and do not print over the holes. Select **Letterhead** as the paper type setting.

**Note:** To load a sheet of paper longer than legal-size, store the rear feed paper support and insert the paper into the rear feed as shown.

4. Slide the edge guides against the paper, but not too tightly.

[Image of edge guides adjustment]

**Note:** Make sure the paper fits under the line indicated by the triangle mark inside the edge guides.
5. Confirm the paper type and size you loaded on the LCD screen and press the **OK** button if correct.

   **Note:** Select **Change** to change the paper settings.

6. Slide out the output tray and open the paper stopper.

Always follow these paper loading guidelines:
- Load only the recommended number of sheets.
- Load paper short edge first and printable side facing up.
- Make sure the paper is under the line indicated by the triangle mark inside the edge guides.
- If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one envelope at a time.
- If print quality declines when printing multiple envelopes, try loading one envelope at a time.
- Check the paper package for any additional loading instructions.

**Paper Loading Capacity**
**Double-sided Printing Capacity**
**Borderless Paper Type Compatibility**

**Parent topic:** Loading Paper

**Related references**
**Paper Loading Capacity**
**Paper Specifications**
Paper Loading Capacity

See the table here for the loading capacity of the rear feed.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size or smaller: 100 sheets</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm]) size: 1 sheet</td>
</tr>
<tr>
<td>Letterhead</td>
<td>Epson Bright White Pro Paper: 100 sheets</td>
</tr>
<tr>
<td></td>
<td>Epson Presentation Paper Matte: 80 sheets</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte: 20 sheets</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Paper Glossy: If paper feeds incorrectly, or printing is uneven or smeared, load 1 sheet at a time.</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Photo Paper Glossy</td>
</tr>
<tr>
<td></td>
<td>Epson Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Photo Paper Semi-gloss</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte Double-sided: 1 sheet</td>
</tr>
<tr>
<td></td>
<td>Epson Photo Quality Self-adhesive Sheets</td>
</tr>
<tr>
<td></td>
<td>Envelopes: 10 envelopes</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper in the Rear Feed

Double-sided Printing Capacity

You can print double-sided using Auto or Manual mode on the paper types and sizes listed here.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Double-sided printing capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Auto</td>
</tr>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size or smaller</td>
<td>100 sheets</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Epson Bright White Pro Paper</td>
<td>100 sheets</td>
</tr>
</tbody>
</table>

|                            |                                           | Manual                          |
|                            |                                           | 30 sheets                       |
|                            |                                           | 1 sheet                         |
|                            |                                           | 30 sheets                       |

You cannot print double-sided on the following paper types:

- Epson Presentation Paper Matte
- Epson Premium Presentation Paper Matte
- Epson Premium Presentation Paper Matte Double-sided
- Epson Ultra Premium Presentation Paper Matte
- Epson Photo Paper Glossy
- Epson Premium Photo Paper Glossy
- Epson Premium Photo Paper Semi-gloss
- Epson Ultra Premium Photo Paper Glossy
- Epson Ultra Premium Photo Paper Luster
- Epson Photo Quality Self-adhesive Sheets
- Letterhead
- Envelopes

Parent topic: Loading Paper in the Rear Feed

**Borderless Paper Type Compatibility**

You can print borderless photos on compatible paper types in compatible sizes:
Borderless Paper Types

• Epson Bright White Pro Paper
• Epson Photo Paper Glossy
• Epson Premium Photo Paper Glossy
• Epson Ultra Premium Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss
• Epson Presentation Paper Matte
• Epson Premium Presentation Paper Matte
• Epson Premium Presentation Paper Matte Double-sided

Borderless Paper Sizes

• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• 16:9 wide (4 × 7.1 inches [102 × 181 mm])
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• Letter (8.5 × 11 inches [216 × 279 mm])

Parent topic: Loading Paper in the Rear Feed

Compatible Epson Papers

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales), epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Pro Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>16:9 wide (4 × 7.1 inches [102 × 181 mm])</td>
<td>S042109</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041106</td>
<td>10</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Paper

**Paper or Media Type Settings - Printing Software**

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td></td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
</tbody>
</table>

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product’s control panel settings.

**Parent topic:** Loading Paper

**Selecting the Paper Settings for Each Source - Control Panel**

You can change the default paper size and paper type for each source using the control panel on the product.
1. Press the \( \text{home} \) button, if necessary.
   
   You see a screen like this:

   ![Paper Setting Screen](image)

   3. Select **Paper Size**.
   4. Select the paper size you loaded.
   5. Select **Paper Type**.
   6. Select the paper type you loaded.
   7. When you are finished, press the \( \text{home} \) button to exit.

   **Paper Type Settings - Control Panel**

   **Parent topic:** Loading Paper

   **Paper Type Settings - Control Panel**

   Select a **Paper Type** setting that matches the paper you loaded.

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Pro Paper</td>
<td></td>
</tr>
<tr>
<td>Letterhead paper</td>
<td>Letterhead</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
### Selecting the Default Paper Source Settings

You can change default paper source settings using the control panel on the product.

1. Press the home button, if necessary.
2. Select Settings > Printer Setup.
   
   You see a screen like this:

   ![Printer Setup Screen](image)

3. Select Auto Error Solver and do one of the following:
   - Select On to display a warning and print single-sided when a 2-sided printing error occurs, or to print only what the printer could process when a memory full error occurs.
   - Select Off to display an error message and stop printing if an error occurs.
4. Select the Paper Source Settings options you want to use.

---

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Prem. Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Prem. Matte</td>
</tr>
</tbody>
</table>
5. When you are finished, press the home button to exit.

**Paper Source Settings Options**

Parent topic: Loading Paper

Paper Source Settings Options

Select the paper source options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Paper Source Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Setting</strong></td>
<td>Various</td>
<td>Select the paper size and type for each paper source</td>
</tr>
<tr>
<td><strong>A4/Letter Auto Switching</strong></td>
<td>On</td>
<td>Select On to switch the selected paper size to match the loaded paper (Letter or A4) if the wrong size is selected</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td><strong>Error Notice</strong></td>
<td>Paper Size Notice</td>
<td>Select On for either of these settings to display an error message when the selected paper type or size does not match the loaded paper</td>
</tr>
<tr>
<td></td>
<td>Paper Type Notice</td>
<td></td>
</tr>
<tr>
<td><strong>Paper Setup Auto Display</strong></td>
<td>On</td>
<td>Select On to automatically display a menu that lets you select the paper size and type when you load paper in the product</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you disable this setting, you cannot use AirPrint.

Parent topic: Selecting the Default Paper Source Settings
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

1. Open the document cover.
2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the original to the edges of the indicated corner.

![Diagram showing original placement](image)

**Note:** The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the scanner glass. Manually position your original away from the edges to prevent cropping.

3. Close the document cover gently to keep your original in place.

**Parent topic:** Placing Originals on the Product

**Related topics**
- Copying
- Faxing
- Scanning

**Placing Originals in the Automatic Document Feeder**

You can place single- or multi-page original documents in the Automatic Document Feeder (ADF). Make sure the originals meet the Automatic Document Feeder specifications before loading them.

**Caution:** Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or other materials that could obstruct the feeder.

**Caution:** Do not place photographs or valuable artwork in the ADF. Place fragile or valuable originals on the scanner glass to avoid wrinkling or damaging them.

**Note:** When originals are placed in the ADF and on the scanner glass, priority is given to the originals in the ADF.
1. Open the ADF input tray.

2. Slide the ADF edge guide outward.

3. Fan your stack of originals and tap them gently on a flat surface to even the edges.
4. Insert the originals into the ADF faceup and short edge first.

**Note:** Do not load originals above the arrow mark on the ADF edge guide.

The **ADF** icon on the Copy, Scan, and Fax screens lights up.
5. Slide the ADF edge guide against the originals, but not too tightly.

**Note:** If you are copying two originals onto one sheet, make sure the originals are loaded as shown. Select the link below to select the copy orientation setting that matches how you loaded your original.

ADF Original Document Specifications

Parent topic: Placing Originals on the Product

Related topics

Copying
Faxing
Scanning

**ADF Original Document Specifications**

You can load original documents that meet these specifications in the ADF.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper size</th>
<th>Paper weight</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>17 to 24 lb (64 to 95 g/m²)</td>
<td>Approximately 30 sheets</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td></td>
<td>10 sheets</td>
</tr>
<tr>
<td></td>
<td>8.5 × 13 inches (216 × 330 mm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Caution:** Do not load the following types of originals in the ADF, or they may be damaged or may damage the scanner. Use the scanner glass for these types:

- Photos
- Thermal paper
- Fabric or other non-paper originals
- Originals with uneven surfaces, such as embossed documents
- Originals containing staples or paper clips
- Originals with carbon paper backing
- Originals with wet ink
- Originals that are bound
- Originals with labels, stickers, or sticky notes
- Ripped, curled, folded, deteriorated, or wrinkled originals
- Originals with holes
- Transparencies
- Carbon-less paper

**Parent topic:** Placing Originals in the Automatic Document Feeder
Copying

See the information here to copy documents or photos using your product.

**Note:** Copies may not be exactly the same size as your originals.

**Copying Documents or Photos**

You can copy color or black-and-white documents or photos onto various sizes and types of paper, including Epson special papers.

1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on in the product.
3. Press the home button, if necessary.
4. Select **Copy**.

   You see this screen:

5. To print more than one copy, use the keypad to enter a number (up to 99).

   **Note:** Press the **C** clear button to clear the amount of copies, if necessary.

6. Press the left or right arrow button to select **Color** or **B&W**.
7. Press the **OK** button to view the print settings for the copies.
   You see this screen:

   ![Screen with print settings]

8. Press the down arrow button to view the individual settings.
   You see this screen:

   ![Screen with individual settings]

9. Press the up or down arrow button to scroll through settings. To change the setting for the displayed option, press the left or right arrow button and select the necessary settings. When you are finished, press the **OK** button.

10. When you are ready to copy, press the ◇ start button.

    **Note:** To cancel copying, press the ◊ cancel button.
### Copying Options

Select the copying options you want to use for your copies.

**Note:** Not all options or settings may be available, depending on other copying settings.

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Sided</td>
<td>1&gt;1-Sided</td>
<td>Select to make 2-sided copies. When you select 1&gt;2-Sided, also select the orientation and binding edge for your originals or copies.</td>
</tr>
<tr>
<td></td>
<td>1&gt;2-Sided</td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjusts the lightness or darkness of copies</td>
</tr>
<tr>
<td>Paper Setting</td>
<td>Paper Size</td>
<td>Selects the paper size</td>
</tr>
<tr>
<td></td>
<td>Paper Type</td>
<td>Selects the paper type</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Actual Size</td>
<td>Copies the original at its full size</td>
</tr>
<tr>
<td></td>
<td>Auto Fit</td>
<td>Automatically sizes the image to fit the paper size you selected</td>
</tr>
<tr>
<td></td>
<td>Custom 100% and other conversions</td>
<td>Displays the amount to re-size the original. Change the amount by adjusting the Custom Size setting.</td>
</tr>
<tr>
<td>Custom Size</td>
<td>25 - 400 in 1% increments</td>
<td>Adjusts the amount to re-size the original.</td>
</tr>
<tr>
<td>Original Size</td>
<td>Letter or A4</td>
<td>Select the document size of your original</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Single Page</td>
<td>Copies each page of the original onto an individual sheet</td>
</tr>
<tr>
<td></td>
<td>2-up</td>
<td>Copies multiple page documents onto one sheet. Select the layout order and orientation settings as necessary.</td>
</tr>
<tr>
<td>Quality</td>
<td>Draft</td>
<td>Adjusts the quality of your copies</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>ID Card Copy</td>
<td>Off</td>
<td>Select On to copy both sides of an ID card onto one side of a sheet of paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Borderless Copy</td>
<td>Off</td>
<td>Adjusts the amount to expand the original photo when printing borderless photos. When you select On, you can select the Expansion settings.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Expansion</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minimum</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Copying
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select **Enable automatic checking** and click **OK**. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

**Printing with Windows**

Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Printing From a Chromebook
Canceling Printing Using a Product Button

**Printing with Windows**

You can print with your product using any Windows application, as described in these sections.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options

**Parent topic:** Printing from a Computer
Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

You see the **Main** tab of your printer settings window:
4. Select the size of the paper you loaded as the **Document Size** setting.
   
   **Note:** You can also select the **User-Defined** setting to create a custom paper size.

5. If you are printing a borderless photo, select **Borderless**. You can click **Settings** to access additional options for borderless printing.
   
   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

6. Select the orientation of your document.
   
   **Note:** If you are printing an envelope, select **Landscape**.

7. Select the type of paper you loaded as the **Paper Type** setting.
   
   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:
   
   • To print a color document or photo, select the **Color** setting.
   
   • To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

10. To print on both sides of the paper, select the **2-Sided Printing** setting and select the options you want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the **Copies** options.

13. To preview your job before printing, select **Print Preview**.

14. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.

15. To reduce noise during printing when you select **Plain Paper/Bright White Paper**, select **On** in the Quiet Mode menu.
   
   **Note:** Enabling **Quiet Mode** may reduce printing speed.
Print Quality Options - Windows
Multi-Page Printing Options - Windows

Parent topic: Printing with Windows

Related references
Borderless Paper Type Compatibility

Related tasks
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows

Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on plain paper.

Standard
For everyday text and image printing.

Standard - Vivid
For text and graphics with good quality and print speed.

High
For photos and graphics with high print quality.

Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
   - Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper on the long edge.
   - Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper on the short edge.
   - Manual (Long-edge binding) to print your double-sided print job by printing one side and prompting you to flip the paper over on the long edge to print the other side (recommended for paper types that do not support automatic duplexing).
   - Manual (Short-edge binding) to print your double-sided print job by printing one side and prompting you to flip the paper over on the short edge to print the other side (recommended for paper types that do not support automatic duplexing).

2. Click the Settings button.
You see this window:

3. Select the double-sided printing options you want to use.
4. Click **OK** to return to the **Main** tab.
5. Click the **Print Density** button.
   You see this window:

   ![Print Density Adjustment Window](image)

6. Select the type of document you are printing as the Document Type setting. The software automatically sets the **Adjustments** options for that document type.

7. If necessary, select the **Adjustments** options you want to use.

8. Click **OK** to return to the **Main** tab.

9. Print a test copy of your double-sided document to test the selected settings.

10. Follow any instructions displayed on the screen during printing.

   - Double-sided Printing Options - Windows
   - Print Density Adjustments - Windows
   - **Parent topic:** Printing with Windows

   **Related references**
   - Double-sided Printing Capacity

   **Related tasks**
   - Selecting Basic Print Settings - Windows
Double-sided Printing Options - Windows

You can select any of the available options on the Binding Settings window to set up your double-sided print job.

**Binding Edge Options**
Select a setting that orients double-sided print binding in the desired direction.

**Binding Margin Options**
Select options that define a wider margin to allow for binding.

**Start Page**
Selects whether printing starts on the front or back page.

**Create Folded Booklet Options**
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows

Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print quality of your double-sided print job.

**Print Density**
Sets the level of ink coverage for double-sided printing.

**Increase Ink Drying Time**
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select one of these sizing options:
   - Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your document or photo as the Document Size setting, and the size of your paper as the Output Paper setting. If you want to center your image on the paper, select the Center option.
   - Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.

2. Select one of the following Color Correction options:
   - Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
• Select Custom and click the Advanced button to manually adjust the color correction settings or turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.

  **Note:** You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:

   • **Anti-Copy Pattern:** adds a watermark that only appears when your printout is copied
   
   • **Watermark:** adds a visible watermark to your printout
   
   • **Header/Footer:** adds information such as the date and time to the top or bottom of your printout

   **Note:** Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

   **Custom Color Correction Options - Windows**
   
   **Image Options and Additional Settings - Windows**
   
   **Header/Footer Settings - Windows**
   
   **Parent topic:** Printing with Windows

   **Related tasks**

   **Printing Your Document or Photo - Windows**
Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

![Color Correction Window](image)

**Color Controls**

- **Color Mode** setting, individual settings for **Brightness**, **Contrast**, **Saturation**, and **Density**, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the **Gamma** setting.

**Fix Photo**

Improves the color, contrast, and sharpness of flawed photos.

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off **Fix Photo** to retain the special color effects.
ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Layout and Print Options - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smoothes jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
**High Speed**  
Speeds up printing but may reduce print quality.

**Mirror Image**  
Flips the printed image left to right.

**Parent topic:** Selecting Additional Layout and Print Options - Windows

**Header/Footer Settings - Windows**

You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

**Note:** These settings are not saved with your document.
You can select to print the following information:

- User Name
- Computer Name
- Date
- Date/Time
- Document Name
- Collate Number
- Page Number
- Text

**Note:** The user name, computer name, date, and time come from the Windows Control Panel on your computer.

**Parent topic:** Selecting Additional Layout and Print Options - Windows

**Selecting a Printing Preset - Windows**

For quick access to common groups of print settings, you can select a printing preset on the **Main** or **More Options** tab.

**Note:** You can create your own preset by clicking the **Add/Remove Presets** button.

1. Click the **Main** or **More Options** tab.
You see the available **Printing Presets** on the left:

2. Place your cursor over one of the **Printing Presets** to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click **OK**.

**Parent topic:** [Printing with Windows](#)

## Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
2. Select **Printer Settings**.
3. Click the **Maintenance** tab.

   You see the maintenance options:

   ![Maintenance Options](image)

4. Click the **Extended Settings** button.
You see this window:

![Extended Settings window]

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.

**Extended Settings - Windows**

**Parent topic:** Printing with Windows

**Extended Settings - Windows**

You can select from these settings on the Extended Settings window.

**Enable EPSON Status Monitor 3**

Enables product monitoring for ink and paper supplies and other issues.

**Separator Page**

Before each document, prints a separator page containing the title, user, date, and time.

**Remove white borders**

Removes white margins that may appear when you print borderless photos.

**Always Spool RAW Datatype**

Increases print speed and may solve other printing problems.
Page Rendering Mode
   Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
   Increases print speed when printing is extremely slow or the print head stops during printing, and
   other settings do not help.

Skip Blank Page
   Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
   Reduces the resolution of print data to correct printing problems.

Refine screening pattern
   Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
   Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
   Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
   Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
   Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
   filing.

Barcode mode
   Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
   preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
   Once you have selected your print settings, you are ready to save your settings and print.
   1. Click OK to save your settings.
You see your application's Print window, such as this one:

2. Click OK or Print to start printing.

Parent topic: Printing with Windows

Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

   • **Windows 10**: Click Settings and select (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Printer properties.

   • **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product and select Printer properties.

   • **Windows 7**: Click and select Devices and Printers. Right-click your product and select Printer properties.
• **Windows Vista:** Click 📶 and select **Control Panel.** Click **Printer** under **Hardware and Sound,** then right-click your product and select **Properties.**

2. Click the **Optional Settings** tab.

   **Note:** You can prevent access to the **Optional Settings** tab by changing the user or group permissions in the **Security** tab.

3. Click **Driver Settings.**

   You see this window:

4. Select the checkbox for each setting you want to lock. To lock all print settings, select **All Document Settings.**

5. Under **Advanced Settings,** select the setting option you want to use for each locked setting.

6. Click **OK.**

   **Locked Setting Options**

   **Parent topic:** Printing with Windows
Locked Setting Options

Select the options you want to use for any locked print settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Copy Pattern</td>
<td>Various data items</td>
<td>Lets you select the data to use for the pattern or prohibit anti-copy patterns</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized anti-copy pattern</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the arrangement, size, and other settings for the custom anti-copy pattern</td>
</tr>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td></td>
<td>Add/Delete</td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>2-sided printing</td>
<td>Off</td>
<td>Allows printing on one side of the paper only</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows printing on both sides of the paper</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

Parent topic: Locking Printer Settings - Windows
Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
   You see the printer settings window:

![Printer Settings Window]

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
   These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.
Changing the Language of the Printer Software Screens

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .

2. Select **Printer Settings**.
   
   You see the printer settings window.

3. Click the **Maintenance** tab.
   
   You see the maintenance options:

   ![Maintenance Tab]

4. Select the language you want to use as the **Language** setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows

### Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .

2. Select **Software Update Settings**.

   You see this window:

   ![Software Update Settings window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click OK to exit.

**Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S

You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your product. To print with additional settings, download and install the Epson Print and Scan utility from the Windows Store. You cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S

Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S

Select the settings for your print job in your Windows 10 S application.

1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
You see a window like this:

4. Select the type of paper you loaded as the **Media** setting.
   
   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

5. Click the **Advanced** button.
You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.
10. Select the **Layout** tab.

11. Select the orientation of your document as the **Orientation** setting.
12. To print double-sided, select one of the **Print on Both Sides** options, depending on how you want to orient the page layout. The icon next to each option shows the layout.

![Print on Both Sides options](image)

13. Click **OK** to save your settings.

You see your application’s **Print** window.

14. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Epson Driver - Windows 10 S

### Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac
Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the **Printer** setting.

![Printer: EPSON](image1)

4. If necessary, click the arrow next to the Printer setting or the **Show Details** button to expand the print window.
You see the expanded printer settings window for your product:

![Expanded Printer Settings Window](image)

**Note:** The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing.

6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.
7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.
9. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

10. Select the **Print Quality** setting you want to use.

11. Select the **Borderless** checkbox if you want to print a borderless photo. If the option is grayed out, change the **Media Type** setting to a paper type that supports borderless printing.

12. Select any of the available print options.

   - [Print Quality Options - Mac](#)
   - [Print Options - Mac](#)

   **Parent topic:** [Printing on a Mac](#)

   **Related references**
   - [Paper or Media Type Settings - Printing Software](#)

   **Related tasks**
   - [Selecting Page Setup Settings - Mac](#)
   - [Printing Your Document or Photo - Mac](#)

### Print Quality Options - Mac

You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

- **Draft**
  - For draft printing on plain paper.

- **Normal**
  - For everyday text and image printing.

- **Normal - Vivid**
  - For everyday text and image printing with good quality and print speed.

- **Fine**
  - For text and graphics with good quality and print speed.

- **Quality**
  - For text and graphics with increased quality and print speed.

**Parent topic:** [Selecting Basic Print Settings - Mac](#)
Print Options - Mac

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed photo.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

Note: If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless photo, select the Borderless checkbox or a paper size with a Borderless option. You can also select a custom setting to create a custom paper size, but the Quality setting will be limited to Normal. You can also select a custom setting to create a custom paper size. The Quality setting will be limited to Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.
2. Select the orientation of your document or photo as shown in the print window.

   Note: If you are printing an envelope, select the icon.

   Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac

Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
- To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
- To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
- To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing on a Mac
Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting **Two-sided Printing Settings** from the pop-up menu on the print window.

![Two-sided Printing Settings](image)

**Note:** Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network. This screen may be different, depending on the Mac OS version you are using.

1. Select one of the **Two-sided Printing** options.
2. Select the type of document you are printing as the **Document Type** setting. The software automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

**Double-sided Printing Options and Adjustments - Mac**

**Parent topic:** Printing on a Mac

**Double-sided Printing Options and Adjustments - Mac**

You can select any of the available options in the **Two-sided Printing Settings** or **Output Settings** pop-up menu to set up your double-sided print job.

**Long-Edge binding**

Orients double-sided printed pages to be bound on the long edge of the paper.
**Short-Edge binding**
Orients double-sided printed pages to be bound on the short edge of the paper.

**Print Density**
Sets the level of ink coverage for double-sided printing.

**Increased Ink Drying Time**
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

### Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or turn off color management in your printer software.

1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching](image)

2. Select one of the available options.

3. Select **Color Options** from the pop-up menu in the print window.

![Color Options](image)
Note: The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

Color Matching and Color Options - Mac

Parent topic: Printing on a Mac

Color Matching and Color Options - Mac

You can select from these settings on the Color Matching and Color Options menus.

**Color Matching Settings**

**EPSON Color Controls**

Lets you manage color using controls in your printer software or turn off color management.

**ColorSync**

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.

**Color Options Settings**

**Manual Settings**

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

**Fix Photo**

Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

**Off (No Color Adjustment)**

Turns off color management in your printer software so you can manage color using only your application software.
Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies.
3. Select Driver or Options.

You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.

Printing Preferences - Mac

Parent topic: Printing on a Mac
**Printing Preferences - Mac**

You can select from these settings on the **Options** or **Driver** tab.

**Skip Blank Page**
Ensures that your product does not print pages that contain no text or images.

**Quiet Mode**
Lessens noise during printing when you select **Plain Paper/Bright White Paper** as the paper Type or Media Type setting.

**Permit temporary black printing**
Allows you to print using black ink when color ink is expended.

**High Speed Printing**
Speeds up printing but may reduce print quality.

**Output documents for filing**
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier filing.

**Remove white borders**
Removes white margins that may appear when you print borderless photos.

**Warning Notifications**
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

**Establish bidirectional communication**
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

**Parent topic:** Selecting Printing Preferences - Mac

**Printing Your Document or Photo - Mac**

Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Print Settings](image)

**Checking Print Status - Mac**

**Parent topic:** Printing on a Mac

**Checking Print Status - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

![Print status window](image)

2. Select the following options as necessary for your Mac OS version:
   - To cancel printing, click the print job and click or **Delete**.
   - To pause a print job, click the print job and click or **Hold**. To resume a print job, click the paused print job and click or **Resume**.
   - To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   - To display other printer information, click **Settings** or **Supply Levels**.

Parent topic: Printing Your Document or Photo - Mac

### Printing From a Chromebook

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.
   
   **Note:** See your Chromebook's documentation for details on connecting to a network.
3. Do one of the following:
   - Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.
Note: If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click Add to Cloud Print.

- Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
- If you see a registration confirmation screen instead, click Register.

4. Click Add Device.
5. Click the Register button that appears next to your product.
6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation message.
7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and print a test page.
8. To print to the connected product, select the print command in your Chrome app.

Your product is now linked to your Google Account and can be accessed from any Chromebook where you are logged in, as long as you have Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Printing from a Computer

Related tasks
Using Google Cloud Print

Cancelling Printing Using a Product Button

If you need to cancel printing, press the ☢️ cancel button.

Parent topic: Printing from a Computer
Scanning

You can scan your originals and save them as digital files.

Starting a Scan
Scanning in Epson Scan 2

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Starting a Scan Using the Product Control Panel
Changing Default Scan Job Settings
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smart Device

Parent topic: Scanning

Starting a Scan Using the Product Control Panel

You can scan an image to your computer using your product's control panel buttons.
Your product automatically selects default scan settings, but you can view or change them as necessary.
If you are scanning to a computer, you can change the default scan settings using the Event Manager utility on the computer.

1. Make sure you installed the product software and connected the product to your computer or network.

   Note: Restart your computer after installing the product software to enable scanning from the control panel. Also make sure the Event Manager program is not being blocked by your firewall or security software.

2. Press the home button, if necessary.
3. Select Scan.
You see a screen like this:

4. Select a scan option:
   • **To Computer (JPEG)** saves your scan as a JPEG file on your computer or as an image capture on a Mac.
   • **To Computer (PDF)** saves your scan as a PDF file on your computer or as an image capture on a Mac.
   • **To Computer (Email)** scans your original and attaches it to a message in your e-mail program. You can select the e-mail program you want to use and resize your image, if necessary, from an option screen on your computer.

   **Note:** This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail, and Entourage, but not web-based email such as Gmail.

   • **To Computer (Custom)** saves your scan using the settings from the Event Manager utility. You can change the scanning size, destination folder, and the save format.

   • **To WSD** lets you manage network scanning in Windows 10, Windows 8.x, Windows 7, or Windows Vista (English only). To use this feature, you must first set up a WSD (Web Services for Devices) port on your Windows 7 or Windows Vista computer (the port is set up automatically on Windows 10 and Windows 8.x).

5. Do one of the following:
   • If you are scanning to a network computer, select the target computer from the list.
   • If your product is connected directly to your computer with a USB cable, select **USB Connection**.

6. Press the start button to start scanning.
Setting Up a WSD Port (Windows 7/Windows Vista)

Parent topic: Starting a Scan

Related topics

Placing Originals on the Product

Setting Up a WSD Port (Windows 7/Windows Vista)

You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on Windows 10 and Windows 8.x).

Before you set up a WSD port, make sure you installed your product software, and connected your product and computer to the same network.

1. Turn on your product.
2. Print a network status sheet so you can identify the network name and model name for your product on the network.
3. Click Start and select Computer.
4. On the left side of the window, select Network.
5. Locate your product on the Network screen, right-click it, and select Install.
6. When you see the User Account Control screen, click Continue.

   **Note:** If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the message.
8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then click Close.
9. Do one of the following:

   - **Windows 7:** Click and select Devices and Printers.

   - **Windows Vista:** Click Start and select Control Panel > Hardware and Sound > Printers.

10. Make sure that an icon appears for your product's name on the network.

   When you use WSD, select your product name to scan over the network.

Parent topic: Starting a Scan Using the Product Control Panel
Changing Default Scan Job Settings

You can view or change the default scan job settings your product uses when you scan to your computer. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:
   - **Windows 10**: Click and select EPSON Software > Event Manager.
   - **Windows 8.x**: Navigate to the Apps screen and select Event Manager.
   - **Windows (other versions)**: Click or Start > All Programs or Programs > EPSON Software > Event Manager.
   - **Mac**: Open the Applications folder, click Epson Software, and select Event Manager.

2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if necessary.

3. Click Make Job Settings.

4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or change.

5. Change the settings as necessary.

6. Click OK.

7. Click Close to close the Event Manager window.

Parent topic: Starting a Scan

Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note**: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

- **Windows 10**: Click and select EPSON > Epson Scan 2.
- **Windows 8.x**: Navigate to the Apps screen and select Epson Scan 2.
• **Windows (other versions):** Click 📱 or **Start**, and select **All Programs** or **Programs**. Select **EPSON > Epson Scan 2 > Epson Scan 2**.

• **Mac:** Open the **Applications** folder, open the **Epson Software** folder, and select **Epson Scan 2**.
You see an Epson Scan 2 window like this:
Parent topic: Starting a Scan

Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a Select Source option, choose it and select your product. With Windows, do not select a WIA option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
Starting a Scan from a Smart Device

You can start a scan from a smart device using the Epson iPrint app. You can save the scanned document to your device or a cloud service, e-mail it, or print it.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

**Note:** Your device must be connected to the same wireless network as your Epson product.

1. Download the Epson iPrint app from your device’s app store or from Epson’s website.
2. Place your original on the product for scanning.
3. Open the Epson iPrint app and select your product.
4. Select the scan settings and scan your original.
5. Save your scanned image to a file or cloud location.

**Parent topic:** Starting a Scan

### Related tasks

- **Using the Epson iPrint Mobile App**

---

### Scanning in Epson Scan 2

Epson Scan 2 automatically scans your document and saves the scanned file in PDF format in your operating system’s Documents or My Documents folder, or opens it in your scanning program. You can select settings, preview, and change the scanned file settings as necessary.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Start Epson Scan 2.
You see this window:
2. Select the **Document Source** setting that matches where you placed your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the source.

3. Select the **Document Size** setting that matches the size of your original. You can select **Customize** to enter a custom size, if necessary.

4. Select the image type of your original and how you want it scanned as the **Image Type** setting.

5. Select the **Resolution** setting you want to use for your scan.

6. Select the **Rotate** setting to rotate the scanned image.

7. Select the **Correct Document Skew** setting to correct skewed originals, image contents, or both.

8. Click the **Preview** button.
   
   Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

9. Reinsert your original into the ADF, if necessary.

10. Select any of the additional settings that you want to use on the Main Settings tab.

11. Click the **Advanced Settings** tab and select any settings that you want to use.

12. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.
13. Enter the file name for your scanned file in the **File Name** field. If necessary, select **Settings** to modify the file name settings.

14. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to create a new folder.

15. Click **Scan**.

   The product scans your original and saves the scanned file in the location you specified.

---

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Rotate**

Rotates the original image clockwise to the desired angle before scanning it. Select **Auto** to allow your product to automatically rotate the image based on the orientation of the text (may take longer to scan).

**Correct Document Skew**

Corrects skewed originals, image contents, or both.

**Add or edit pages after scanning**

Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page order.

**Note:** To save multiple pages in a single file, you must select a file format that supports multiple pages such as **PDF** or **Multi-TIFF**. If you select another file format, each scanned image or page is saved as a separate file.

---

**Parent topic:** Scanning in Epson Scan 2

**Additional Scanning Settings - Advanced Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.
Remove Background
   Removes the background of the originals.

Text Enhancement
   Sharpens the appearance of letters in text documents.

Auto Area Segmentation
   Makes black and white images clearer and text recognition more accurate by separating the text from
   the graphics.

Threshold
   Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
   OCR (Optical Character Recognition) programs.

Color Enhance
   Enhances the shades of the color you select in the scanned image. This setting is available only if you
   select Grayscale or Black & White as the Image Type setting.

Brightness
   Adjusts the overall lightness and darkness of the scanned image.

Contrast
   Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
   Adjusts the midtone density of the scanned image.

Unsharp Mask
   Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
   Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
   option improves results when scanning magazines or newspapers. (The results of descreening do not
   appear in the preview image, only in your scanned image.)

Edge Fill
   Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
   Scans the original image twice using different output settings (Windows only).

Watermark
   Adds a watermark to a scanned image.

Parent topic: Scanning in Epson Scan 2
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

**Note:** The required Epson Scan 2 OCR Component is installed automatically when you install your product software as instructed on the *Start Here* sheet. If you install your scanner software programs individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click **Preview** and adjust the area you want to scan, if necessary.
5. If you are using the ADF, reload the ejected original.
6. Select **Searchable PDF** as the Image Format setting.
7. Select **Options** from the Image Format list.

You see this window:
8. Select any of the options on the **General** tab.
9. Select the **Text** tab.
10. Make sure the language used in the document text is selected as the **Text Language** setting.
11. Select the **Security** tab if you want to add a password to the PDF or protect printing or editing properties.
12. Click **OK**.
13. Confirm the **File Name** setting and select a **Folder** setting for your document.
14. Click **Scan**.
   The scanned image is saved as a searchable PDF.

**Parent topic:** [Scanning in Epson Scan 2](#)

### Image Format Options

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

**BITMAP (*.bmp)**
A standard image file format for most Windows programs.

**JPEG (*.jpg)**
An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)

**PNG (*.png)**
An image format that does not lose quality during editing.

**TIFF (*.tif)**
A file format created for exchanging data between many programs, such as graphic and DTP software.

**Multi-TIFF (*.tif)**
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

**PDF (*.pdf)**
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.
**Searchable PDF (*.pdf)**

A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

**Parent topic:** Scanning in Epson Scan 2

---

**Scan Resolution Guidelines**

The **Resolution** setting, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

- Larger file sizes
- It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
- The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the resolution setting you need:

- **You will scan the image at its original size but enlarge it later in an image-editing program.**
  
  Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

- **You will scan the image at 100% or smaller size.**

  Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:

  - **Email/view on a computer screen/post on the web:** 96 to 200 dpi
  - **Print/fax/convert to editable text (OCR)/create searchable PDF:** 200 to 300 dpi

**Parent topic:** Scanning in Epson Scan 2
Faxing

See these sections to fax using your product.

**Note:** This product allows you to store names, telephone numbers, and fax data in its memory even when the power is turned off. Make sure you restore all of the default settings if you give away or dispose of the product. This will erase all of your network settings and fax data.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Contacts and Contact Groups
Sending Faxes
Receiving Faxes
Checking Fax Status
Printing Fax Reports

**Connecting a Telephone or Answering Machine**

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the same telephone line to receive calls, you can connect a telephone or answering machine to your product using an additional phone cable.

**Note:** If you do not connect a telephone to your product, make sure Receive Mode is set to **Auto**. Otherwise, you cannot receive faxes.
1. Connect a phone cable to your telephone wall jack and to the **LINE** port on your product.

**Note:** If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your product. Contact your DSL or ISDN provider for the necessary equipment.
2. If you are connecting a telephone or answering machine to your product using a second phone cable, remove the cap from the **EXT** port on your product.
3. Connect a second phone cable to your telephone or answering machine and to the **EXT** port on your product.

**Note:** If you connect an answering machine and Receive Mode is set to **Auto**, set the number of rings before your product answers a call to a number that is higher than your answering machine's setting for the number of rings.

**Parent topic:** Faxing

**Related tasks**
- Receiving Faxes Automatically
- Setting the Number of Rings to Answer

### Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

**Note:** If you leave your product unplugged for a long period of time, you may need to reset the date and time settings for faxes.
Setting Up Basic Fax Features

See these sections to select the basic settings you need to use the product's fax features.

Using the Fax Setup Wizard
Selecting the Line Type
Setting the Number of Rings to Answer

Parent topic: Setting Up Fax Features

Using the Fax Setup Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically displayed when the product is turned on for the first time. You can also change these settings individually from the Fax Settings menu.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings.

You see a screen like this:

3. Select Fax Setting Wizard.
4. Press the OK button to proceed.
5. On the Enter Fax Header screen, use the displayed keypad to enter the sender name for your fax source, such as your name or a business name. You can enter up to 40 characters. Select OK when finished.

6. On the Your Phone Number screen, use the keypad to enter your fax number, up to 20 characters. Press the OK button to proceed.

   Note: The name and phone number in the fax header identifies the source of the faxes you send.

7. On the DRD Setting screen, do one of the following:
   • If you have subscribed to a distinctive ring service from your telephone company, press the OK button to select Settings. Select the ring pattern to be used for incoming faxes. Go to step 10.
   • If you do not have a distinctive ring service, press the # button to select Skip and go to the next step.

   Note: Distinctive ring services allows you to have several phone numbers on one phone line. Each number is assigned a different ring pattern. You can use one number for voice calls and another for fax calls. Select the ring pattern assigned to fax calls in the Distinctive Ring Setting. If you select a ring pattern other than All, Receive Mode is automatically set to Auto.

8. On the Receive Mode Setting screen, do one of the following:
   • If you have connected an external telephone or answering machine to the product, press the OK button to select Yes and go to the next step.
   • If you did not connect an external telephone or answering machine, press the cancel button to select No and go to step 10. (Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)

9. On the next Receive Mode Setting screen, press the OK button to select Yes to receive faxes automatically or press the cancel button to select No to receive faxes manually.

   Note: If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to answer every call and operate the product’s control panel or your phone to receive faxes.

10. On the Confirmation screen, confirm the displayed settings and press the OK button to select Proceed, or press the back button to change the settings.
11. On the Check Fax Connection screen, press the OK button to select Start Checking and follow the on-screen instructions to check the fax connection and print a report of the check result. If there are any errors reported, try the solutions on the report and run the check again.

If the Select Line Type screen appears, select the correct line type.

If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone detection function may drop the first digit of a fax number and send the fax to the wrong number.

**Parent topic:** Setting Up Basic Fax Features

**Related references**

- [Entering Characters on the LCD Screen](#)

**Selecting the Line Type**

If you connect the product to a PBX phone system or terminal adapter, you must change the product's line type. PBX (Private Branch Exchange) is used in office environments where an external access code such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched Telephone Network), which is a standard home phone line.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings > Basic Settings > Line Type > PBX.

You see a screen like this:

![Access Code](image)

3. Select Use to activate the setting.
4. Use the keypad to enter the access code, such as 9, and press the OK button.

**Parent topic:** Setting Up Basic Fax Features
Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. The number of rings should be higher than the number of rings your answering machine is set to for answering a call.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings > Basic Settings > Rings to Answer.

You see a screen like this:

3. Use the keypad to enter the number of rings, then press the OK button. Make sure to select a number higher than the number of rings your answering machine is set to for answering a call.

Note: An answering machine picks up every call faster than the product, but the product can detect fax tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has started receiving the fax, then hang up the phone.

Parent topic: Setting Up Basic Fax Features

Selecting Advanced Fax Settings

You can select a variety of advanced fax settings.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings.
You see a screen like this:

3. Select the group of settings you want to change.

Basic Settings - Fax
Receive Settings - Fax
Report Settings - Fax
Security Settings - Fax

Parent topic: Setting Up Fax Features

Basic Settings - Fax

Set the basic options you want to use for incoming and outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Speed</td>
<td>Fast(33,600bps)</td>
<td>Sets the speed at which you send and receive faxes.</td>
</tr>
<tr>
<td></td>
<td>Medium(14,400bps)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow(9,600bps)</td>
<td></td>
</tr>
<tr>
<td>ECM</td>
<td>Off</td>
<td>Turns off Error Correction Mode (ECM) to automatically correct errors in sent or received fax data.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Turns on Error Correction Mode (ECM); color faxes cannot be sent or received.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dial Tone Detection</td>
<td>Off</td>
<td>Turns off automatic dial tone detection, which may be necessary if the product is connected to a PBX (Private Branch Exchange) or a TA (Terminal Adapter). However, turning this setting off may cause the product to drop the first digit of a fax number.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Automatically dials the number you enter for faxing when the product detects a dial tone.</td>
</tr>
<tr>
<td>Line Type</td>
<td>PSTN</td>
<td>Selects a standard phone line (Public Switched Telephone Network).</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
<td>Selects Private Branch Exchange, the type of phone line used in office environments where an access code such as 9 must be used to call an outside line.</td>
</tr>
<tr>
<td>Header</td>
<td>Your Phone Number</td>
<td>Select to enter your phone number and header information for inclusion on outgoing faxes.</td>
</tr>
<tr>
<td></td>
<td>Fax Header</td>
<td></td>
</tr>
<tr>
<td>Receive Mode</td>
<td>Manual</td>
<td>Lets you confirm whether an incoming fax should be printed; a telephone must be connected to the product</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>Automatically receives and prints faxes.</td>
</tr>
<tr>
<td>Distinctive Ring</td>
<td>All</td>
<td>If you are using a Distinctive Ring Service on your phone line, your telephone company can assign two or more phone numbers to the same line and assign different ring patterns to each. If you use this service, select the number of rings for your fax number so your product can receive faxes on the correct number of rings. Select All for phones lines that do not use this service.</td>
</tr>
<tr>
<td></td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triple</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double&amp;Triple</td>
<td></td>
</tr>
<tr>
<td>Rings to Answer</td>
<td>1 to 9</td>
<td>Sets the number of rings before your product receives a fax. If Receive Mode is set to Auto and an answering machine is connected to the product, make sure this setting is set higher than the number of rings your answering machine is set to answer a call.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>Off</td>
<td>Lets you start receiving faxes using your phone instead of operating the product (if the Receive Mode is set to Auto). When you select On, you must also enter a <strong>Start Code</strong>. If you are using a cordless handset with its base connected to the product, you can start receiving the fax by entering the code using the handset.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Rejection Fax</td>
<td>Various</td>
<td>Lets you automatically reject faxes from blocked numbers, with blank headers, or from unrecognized contacts.</td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting Advanced Fax Settings

**Receive Settings - Fax**

Set the receive options you want to use for incoming faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to Computer</td>
<td>No</td>
<td>Select Yes to save received faxes as PDF files to a connected computer when using FAX Utility. After selecting Yes, you can select Yes and Print.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes and Print</td>
<td></td>
</tr>
<tr>
<td>Auto Reduction</td>
<td>Off</td>
<td>Select to print large incoming faxes at their original size on multiple sheets, if necessary.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Select to reduce the size of large received faxes to fit on the paper size in the selected paper source.</td>
</tr>
<tr>
<td>Split Page Settings</td>
<td>Delete Print Data After Split</td>
<td>Select how to split large incoming faxes across multiple sheets.</td>
</tr>
<tr>
<td></td>
<td>Overlap When Split</td>
<td></td>
</tr>
<tr>
<td>Auto Rotation</td>
<td>Off</td>
<td>If you have loaded A5-size paper, select On to rotate landscape-oriented incoming faxes so that they print correctly on the paper.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Add Reception</td>
<td>Off</td>
<td>Select On to include the date, time, the sender's information, and a page number in your incoming faxes.</td>
</tr>
<tr>
<td>Information</td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>
### Setting Options Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Sided</td>
<td>Off</td>
<td>Select <strong>On</strong> to print incoming faxes double sided. You can also select the Binding Margin.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Print Start Timing</td>
<td>All Pages Received</td>
<td>Select to print incoming faxes after the product receives all of the pages of the document.</td>
</tr>
<tr>
<td></td>
<td>First Page Received</td>
<td>Select to print incoming faxes as soon as the product receives the first page of the document.</td>
</tr>
<tr>
<td>Collation Stack</td>
<td>Off</td>
<td>Select <strong>On</strong> to print incoming faxes so that the pages are stacked in the correct page order. (When the product is low on memory, this option may not be available.)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Print Suspend Time</td>
<td>Off</td>
<td>Select <strong>On</strong> to set a time period to stop automatic printing of faxes or reports and save received faxes in the product's memory. (Make sure there is enough free memory before using this function.)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Quiet Mode</td>
<td>Off</td>
<td>Select <strong>On</strong> to reduce noise during printing. (Printing speed may be reduced.)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting Advanced Fax Settings

### Report Settings - Fax

Set the fax report options you want to use.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Log Auto Print</td>
<td>Off</td>
<td>Select when to automatically print the fax log</td>
</tr>
<tr>
<td></td>
<td>On(Every 30)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On(Time)</td>
<td></td>
</tr>
<tr>
<td>Attach Fax image to Report</td>
<td>Off</td>
<td>Prints a transmission report with an image of the first page of the faxed document</td>
</tr>
<tr>
<td></td>
<td>On(Large Image)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On(Small Image)</td>
<td></td>
</tr>
<tr>
<td>Report Format</td>
<td>Simple</td>
<td>Selects a format for the printed fax report. Select <strong>Detail</strong> to include error codes.</td>
</tr>
<tr>
<td></td>
<td>Detail</td>
<td></td>
</tr>
</tbody>
</table>
Security Settings - Fax

Set the security options you want to use for fax data.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Dialing Restrictions</td>
<td>Off</td>
<td>Does not restrict dialed fax numbers.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows faxing only to numbers stored in the contacts list or history.</td>
</tr>
<tr>
<td></td>
<td>Enter Twice</td>
<td>Requires you to enter fax numbers twice to prevent errors.</td>
</tr>
<tr>
<td>Confirm Address List</td>
<td>Off</td>
<td>Selects whether or not to display a recipient confirmation screen before a fax is sent.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Backup Data Auto Clear</td>
<td>Off</td>
<td>Automatically erases sent or received fax data from your product's memory.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Clear Backup Data</td>
<td>—</td>
<td>Deletes all sent or received fax data remaining in your product's memory; run this function if you are giving away or disposing of your product.</td>
</tr>
</tbody>
</table>

Setting Up the Fax Utility - Windows

You can set up the FAX Utility for Windows for use with your product.

**Note:** Before using the FAX Utility for Windows, make sure you have set up the fax features on your product using the product control panel. Also first confirm that you can send and receive faxes using the control panel.

1. Do one of the following:
   - **Windows 10:** Click 📦 and select EPSON Software.
   - **Windows 8.x:** Navigate to the Apps screen.
   - **Windows (other versions):** Click 🕳️ or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
You see this window:

![FAX Utility window](image)

4. Click **Select Printer** and follow the on-screen instructions to transfer your product’s fax settings to the FAX Utility.

   **Note:** For detailed information, click **Help** or **Open Online Help**.

**Parent topic:** Setting Up Fax Features

**Setting Up Fax Features Using the Fax Utility - Mac**

You can set up your fax header and select your fax settings using the FAX Utility for Mac.
1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select the **FAX** option for your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Double-click **FAX Utility**, if necessary.

You see this window:

![FAX Utility window](image)

3. Select your **FAX** product in the Printer list.

4. Select **Fax Settings**.

5. Follow the prompts that appear on the screen to enter your fax header information and select your fax settings.

   **Note:** For detailed information, select the FAX Utility ? icon.

**Parent topic:** Setting Up Fax Features

### Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You can also set up contact groups to send a fax message to multiple contacts.

**Setting Up Contacts Using the Product Control Panel**

**Importing Contacts Using the Fax Utility - Windows**

**Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac**
Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.

Creating a Contact
Editing or Deleting a Contact
Creating a Contact Group
Editing or Deleting a Contact Group

Parent topic: Setting Up Contacts and Contact Groups

Related tasks
Importing Contacts Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac

Creating a Contact

You can create a list of contacts to save frequently used fax numbers.

Note: You can create up to 100 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax Control Panel]

3. Press the up arrow button to select Contacts.
You see a screen like this:

4. Press the OK button to select **Contacts Manager**.
   You see a screen like this:

   ![Contacts Manager screenshot]

5. Select **Add Entry**.
6. Select the registry number you want to use for the contact you are adding.
7. Enter the contact name (up to 30 characters), and select **OK**.
8. Enter the index word to use when searching for an entry (up to 30 characters), and select **OK**. (This field is optional.)
9. Use the keypad to enter the fax number. You can enter up to 64 characters. Press the OK button when you are done.

Note: If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the Line Type setting, enter the # pound sign instead of the code.

10. Select the communication mode speed.
11. Review the entry details and press the OK button to select Add Entry.

Parent topic: Setting Up Contacts Using the Product Control Panel

Editing or Deleting a Contact
You can edit or delete any of the contacts on your list.
1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax screen](image)

3. Press the OK button to select Menu.
You see a screen like this:

4. Select **Contacts Manager**.
5. Do one of the following:
   - To edit an entry, select **Edit**. Select the entry you want to edit and press the **OK** button. Follow the on-screen instructions to revise the information as necessary.
   - To delete an entry, select **Delete**. Select the entry you want to delete and press the **OK** button. Press the **OK** button again to delete the entry, or press the ☐️ cancel button to go back.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

**Creating a Contact Group**

You can create a group of contacts so that you can easily send faxes to multiple recipients.

**Note:** You can create up to 100 contacts and contact groups combined. You must create a contact before creating a contact group.

1. Press the 🏡 home button, if necessary.
2. Select Fax.
You see a screen like this:

3. Press the OK button to select **Menu**.
   You see a screen like this:

4. Select **Contacts Manager**.
5. Select **Add Group**.
6. Select the registry number you want to use for the group you are adding.
7. Enter the group name (up to 30 characters), and select **OK**.
8. Enter the index word to use when searching for a group (up to 30 characters), and select **OK**. (This field is optional.)
9. Select each contact you want to include in your group by pressing the right arrow button, then press the OK button.
   A check mark appears next to each selected contact.
10. Press the OK button to select Add Entry.

Parent topic: Setting Up Contacts Using the Product Control Panel

Editing or Deleting a Contact Group

You can edit an existing contact group to add or delete entries. You can also delete the entire contact group.

1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax screen](image)

3. Press the OK button to select Menu.
You see a screen like this:

```
Menu
- Scan Settings
- Fax Send Settings
- More
- Contacts Manager

OK Proceed
```

4. Select **Contacts Manager**.

5. Do one of the following:
   - To edit an entry, select **Edit**. Select the entry you want to edit and press the OK button. Follow the on-screen instructions to revise the information as necessary.
   - To delete an entry, select **Delete**. Select the entry you want to delete and press the OK button. Press the OK button again to delete the entry, or press the cancel button to go back.

Parent topic: Setting Up Contacts Using the Product Control Panel

## Importing Contacts Using the Fax Utility - Windows

You can edit contacts stored in your product and import contacts from your Windows Address Book to the PC-FAX Phone Book in the FAX Utility for Windows.

1. Do one of the following:
   - **Windows 10**: Click and select **EPSON Software**.
   - **Windows 8.x**: Navigate to the **Apps** screen.
   - **Windows (other versions)**: Click or Start > Programs or All Programs > EPSON Software.

2. Select **FAX Utility**.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Close** at the bottom of the window.
You see this window:

4. To edit the contacts list on your product, click **Contacts**.
5. Do one of the following:
   • To edit a contact, select it in the list and click the 📞 icon.
   • To delete a contact, select it in the list and click the ✗ icon.
6. To import fax numbers from your Windows Address Book into the FAX Utility PC-FAX Phone Book, select **Edit PC-FAX Phone Book**.
You see this window:

![Image of a window with options for importing from Windows Address Book]

7. Select **File > Import From Windows Address Book**.
8. Select the contacts you want to import and click **OK**.

**Note:** For detailed information, select **Help** or **Open Online Help**.

**Parent topic:** Setting Up Contacts and Contact Groups

### Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

**Note:** You can create up to 60 speed dial and group dial entries combined.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select the **FAX** option for your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
2. Double-click **FAX Utility**, if necessary.
You see this window:

3. Select your **FAX** product in the Printer list.
4. Select **Speed Dial/Group Dial List**.
   You see this window:
5. To add an entry, double-click an empty entry.

   **Note:** To edit an entry, select it and change the information. To delete an entry, select it and press the **Delete** key on your keyboard.

6. Do one of the following:
   - To create a speed dial entry, select **Speed Dial**, enter a name and fax number, and click **OK**.
   - To create a group dial entry, select **Group Dial**, enter a name, select your desired fax numbers, and click **OK**.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the icon.

9. When you are finished, click the icon to save the entries to your product's memory.

**Parent topic:** Setting Up Contacts and Contact Groups

### Sending Faxes

See these sections to send faxes using your product.

- Sending Faxes from the Product Control Panel
- Sending Faxes Using the Fax Utility - Windows
- Sending Faxes Using the Fax Utility - Mac

**Parent topic:** Faxing

### Sending Faxes from the Product Control Panel

See these sections to send faxes using the product's control panel.

- Sending a Fax Using the Keypad, Contact List, or History
- Fax Sending Options
- Sending a Fax at a Specified Time

**Parent topic:** Sending

### Sending a Fax Using the Keypad, Contact List, or History

You can send a fax from your product control panel by entering the fax number, or selecting the number from either the contact list or fax history.
**Note:** You can send a black-and-white fax to up to 100 contacts or 99 groups at a time, or send a color fax to one recipient at a time. If your recipient's fax machine does not print in color, your fax is automatically sent in black-and-white.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select **Fax**.

   You see a screen like this:

   ![Fax Screen](image)

4. Do one of the following to select fax recipients:
   - **Manually enter a fax number:** Use the keypad to enter a fax number, then press the **OK** button. To add another fax number, repeat the same steps.

     **Note:** If direct dialing has been restricted, you can only select the number from the contact list or fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the **Line Type** setting, enter the # pound sign instead of the code. If your fax number requires a brief pause, select - to insert a pause symbol (–).

   - **Select from the contact list:** Press the up arrow button to display the contact list. Press the **OK** button to select or deselect each contact. Press the **back** button when you are finished.
• **Select from the sent fax history:** Press the down arrow button to display the sent fax history. Select a recipient from the list.

**Note:** To delete entered recipients, press the right arrow button, select the recipient you want to delete, and press the back button when you are finished.

5. If you need to change any fax settings, press the **OK** button to select **Menu** and change any necessary settings.

6. Press the start button to send the fax.

**Note:** To cancel faxing, press the cancel button.

After scanning your originals, your product dials the number and sends the fax.

**Parent topic:** Sending Faxes from the Product Control Panel

**Related references**

Fax Sending Options

**Related tasks**

Selecting the Line Type

**Related topics**

Placing Originals on the Product

Setting Up Contacts Using the Product Control Panel

**Fax Sending Options**

Before sending a fax, you can press the **OK** button to select **Menu** and change any of these options.

**Scan Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td><em>Standard</em></td>
<td>Adjusts the scan resolution and print quality of outgoing faxes</td>
</tr>
<tr>
<td></td>
<td><em>Fine</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Photo</em></td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels available</td>
<td>Lets you select from various density levels</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>ADF Continuous Scan</strong></td>
<td>Off</td>
<td>Select <strong>On</strong> to have the product to ask if you want to scan another page after a document in the ADF has finished scanning</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Original Size (Glass)</strong></td>
<td>Half Letter</td>
<td>Sets the size for a document placed on the scanner glass</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td><strong>Color Mode</strong></td>
<td>B&amp;W</td>
<td>Select whether to scan images in black and white or color</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td></td>
</tr>
</tbody>
</table>

**Fax Send Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Direct Send</strong></td>
<td>Off</td>
<td>Select <strong>On</strong> to send black-and-white faxes to a single recipient as soon as the connection is made, without saving the scanned image to memory. You cannot use this setting when sending a color fax or sending a fax to multiple recipients.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Send Fax Later</strong></td>
<td>Off</td>
<td>Select <strong>On</strong> to send the current fax at a selected time</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td><strong>Add Sender Info</strong></td>
<td>Off</td>
<td>Lets you include a header, your phone number, or a destination list in the selected location on your outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Outside of Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside of Image</td>
<td></td>
</tr>
<tr>
<td><strong>Fax Header</strong></td>
<td>—</td>
<td>Displays the current fax header</td>
</tr>
<tr>
<td><strong>Additional Header Info</strong></td>
<td>Your Phone Number</td>
<td>Selects which additional information is included on the fax header</td>
</tr>
<tr>
<td></td>
<td>Destination List</td>
<td></td>
</tr>
<tr>
<td><strong>Transmission Report</strong></td>
<td>Print on Error</td>
<td>Lets you select when to print transmission reports</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do Not Print</td>
<td></td>
</tr>
</tbody>
</table>
Sending a Fax at a Specified Time

You can send a fax at a time of your choice.

**Note:** Make sure the product's date and time settings are correct. You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax.
   
   You see a screen like this:

   ![Fax screen](image)

4. Enter a fax number or select a number from the Contacts or Recent lists.
5. Press the OK button to select Menu.
6. Select Fax Send Settings.
7. Select Send Fax Later.
8. Select On.
9. Enter your desired time and press the OK button.
10. Press the back button twice to return to the main fax screen.
11. Press the start button to send the fax.

**Note:** To cancel faxing, press the cancel button.
After scanning your originals, your product dials the number and sends the fax at the specified time.

**Note:** If the product is turned off at the specified time, the fax is sent when it is powered on.

**Parent topic:** Sending Faxes from the Product Control Panel

### Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax and select the print command.
   
   You see a window like this:

   ![Print window](image)

   2. Select your product with the **FAX** option as the printer.
3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the Preferences or Properties button.

   **Note:** If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen. For more information about selecting fax print settings, click Help.

4. Select the Page Range as necessary. (Leave the Number of copies set to 1.)
5. Click Print or OK.

   If you’re faxing for the first time, you see a window like this one:

   ![Enter Sender Information Window]

6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to save the sender information.
7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click **Next**.

   **Note:** For detailed instructions on using the Epson FAX Utility, click **Help**.

8. Select a cover sheet and enter a subject and message, then click **Next**.

9. Click **Send** to transmit your fax.

**Parent topic:** Sending Faxes

## Sending Faxes Using the Fax Utility - Mac

You can send a fax from a Mac printing program using the FAX Utility. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product **FAX** option as the Printer setting.
4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
5. Select the number of pages you are faxing as the Pages setting.

   **Note:** Leave the Copies setting set to 1.
6. Select **Recipient Settings** from the pop-up menu.
You see this window:

7. Do one of the following to choose your recipient:
   • Select a name or group from the Recipient List.
   • Enter a name, company, and fax number and click the + button.
   • Click the icon and select a recipient from your address book.
8. Select Fax Settings from the pop-up menu.
You see this window:

![Fax Settings Window](image)

9. Select the **Color** and **Image Quality** settings you want to use for your fax.
10. Click **Fax**.

Parent topic: Sending Faxes

### Receiving Faxes

See these sections to receive faxes with your product.

- Fax Reception
- Receiving Faxes Automatically
- Receiving Faxes Manually
- Receiving a Fax by Polling
- Selecting Received Fax Options Using the Fax Utility - Windows

Parent topic: Faxing

### Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to **Auto**.

If you connected a telephone to your product so you can use the same phone line for faxes and voice calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone using the telephone and press a button on your product to receive the fax.
Make sure to load paper in your product and select your fax settings before receiving a fax.

**Note:** If you run out of paper during fax printing, load more paper and press the button indicated on your product’s LCD screen to continue.

**Parent topic:** Receiving Faxes

---

**Receiving Faxes Automatically**

To receive faxes automatically, make sure Receive Mode is set to **Auto** (the default setting for the product).

To change the Receive Mode if necessary, select **Settings > Fax Settings > Basic Settings > Receive Mode**.

If an answering machine is connected, make sure the product's **Rings to Answer** setting is set higher than the number of rings your answering machine is set to answer a call. For example, if the answering machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

**Parent topic:** Receiving Faxes

**Related references**

- Basic Settings - Fax

**Related tasks**

- Receiving Faxes Manually

---

**Receiving Faxes Manually**

You can set up your product to receive faxes manually by setting the Receive Mode to **Manual**. This lets you check for a fax tone on the connected telephone before receiving a fax.

1. To change the Receive Mode, select **Settings > Fax Settings > Basic Settings > Receive Mode** and select **Manual**.
2. When the connected telephone rings, answer the call.
3. If you hear a fax tone, select **Fax**.
4. Press the # button to receive the fax.
5. Press the start button to start receiving the fax.
6. Hang up the telephone.

**Parent topic:** Receiving Faxes
Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

**Note:** You cannot use polling to receive a fax from a fax information service that uses audio guidance.

1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax Screen]

3. Press the OK button to select Menu.
4. Select More.
5. Select Polling Receive.
7. Enter the fax number you expect to receive the fax from.

   **Note:** If direct dialing has been restricted, you can only select the number from the contact list or fax history.
8. Press the start button to start receiving the fax.

Parent topic: Receiving Faxes

Selecting Received Fax Options Using the Fax Utility - Windows

You can select options for use with received faxes using the FAX Utility for Windows.

1. Do one of the following:
   - **Windows 10:** Click and select EPSON Software.
   - **Windows 8.x:** Navigate to the Apps screen.
   - **Windows (other versions):** Click or Start > Programs or All Programs > EPSON Software.

2. Select FAX Utility.

The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click Close at the bottom of the window.
You see this window:

4. To save faxes received by your product on your computer, select **Save received faxes on this computer**.
5. Select the destination folder and other options, and click **OK**. You return to the FAX Utility window.
6. To receive notifications when received faxes arrive in the selected destination folder on your computer, select **Notify me if new faxes exist in forwarding folders**.
7. Select how often you want to be notified of received faxes and click OK.

Note: For detailed information, click Help or Open Online Help.

Parent topic: Receiving Faxes

Checking Fax Status

You can check the status of current fax jobs, or faxes that have been received or sent on the product control panel.

1. Press the home button, if necessary.
2. Select Fax.
   
   You see a screen like this:

   ![Fax screen]

3. Press the OK button to select Menu.
4. Select More.
5. To check the history of faxes that have been sent, received, or saved, select Transmission Log and select the job you want to check.

   Note: If the received fax light is flashing, received faxes have been temporarily saved to the product's memory.

Parent topic: Faxing
Printing Fax Reports

You can print several types of fax reports whenever necessary. You can also print the fax log printed automatically by turning on Fax Log Auto Print.

1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax Menu Screen]

3. Press the OK button to select Menu.
4. Select More.
5. Select Fax Report.
6. Select the fax report you want to print.

   Fax Report Options

Parent topic: Faxing

Fax Report Options

Select the fax report or list you want to print.

Last Transmission
   Prints a report for the previously sent fax or fax received through polling.

Fax Log
   Prints the fax log.
Fax Settings List
Prints the current fax settings.

Protocol Trace
Prints a detailed report for the previously sent or received fax.

Parent topic: Printing Fax Reports
Replacing Ink Cartridges and Maintenance Boxes

The maintenance box stores ink that gets flushed from the system during print head cleaning. When an ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly and in accordance with local requirements. If you would like to return your used ink cartridges and maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows
Maintenance Box Replacement

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the maintenance box needs to be replaced.

Checking Cartridge and Maintenance Box Status on the LCD Screen
Checking Cartridge and Maintenance Box Status - Windows
Checking Cartridge and Maintenance Box Status - Mac

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Cartridge and Maintenance Box Status on the LCD Screen

You can check the status of the cartridges and maintenance box using the product's LCD screen.

1. Press the home button, if necessary.
2. Select Settings.
You see a screen like this:

![Settings](image)

3. Select **Supply Status**.
4. Do one of the following:
   • Select **Ink Level** to display the ink cartridge levels for each color. Press the **OK** button when you are done.
   • Select **Maintenance Box Service Life** to display the maintenance box capacity. Press the **OK** button when you are done.

   **Note:** The displayed ink and maintenance box levels are approximate.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related concepts**
- Maintenance Box Replacement

**Related tasks**
- Removing and Installing Ink Cartridges

### Checking Cartridge and Maintenance Box Status - Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge or maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop and double-click the **printer** icon for your product in the right side of the Windows taskbar, or click the up arrow and double-click **Details**.
You see this window:

2. Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select **Monitoring Preferences**.
You see this window:

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
6. Click OK.

Parent topic: Check Cartridge and Maintenance Box Status
Checking Cartridge and Maintenance Box Status - Mac

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Select EPSON Status Monitor.

You see this window:
3. Do the following as necessary:
   • You can update the ink cartridge and maintenance box status by clicking **Update**.
   • Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

   **Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

**Parent topic:** Check Cartridge and Maintenance Box Status

**Related concepts**

- **Maintenance Box Replacement**

**Related tasks**

- **Removing and Installing Ink Cartridges**

---

**Purchase Epson Ink Cartridges and Maintenance Box**

You can purchase genuine Epson ink, maintenance boxes, and paper at **epson.com** (U.S. sales), **epson.ca** (Canadian sales), or **epson.com.jm** (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Note:** This printer is designed for use with Epson cartridges only, not third-party cartridges or ink. Other brands of ink supplies are not compatible and, if described as compatible, may not function properly or continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank cartridge-free printers.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced cartridges.

**Ink Cartridge and Maintenance Box Part Numbers**

**Parent topic:** Replacing Ink Cartridges and Maintenance Boxes

---

**Ink Cartridge and Maintenance Box Part Numbers**

Use these part numbers when you order or purchase a new maintenance box or ink cartridges.
Maintenance box part number: C9344

Note: For best printing results, use up a cartridge within 6 months of opening the package.

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Standard-capacity</td>
<td>High-capacity</td>
</tr>
<tr>
<td>Black</td>
<td>212</td>
<td>212XL</td>
</tr>
<tr>
<td>Cyan</td>
<td>212</td>
<td>212XL</td>
</tr>
<tr>
<td>Magenta</td>
<td>212</td>
<td>212XL</td>
</tr>
<tr>
<td>Yellow</td>
<td>212</td>
<td>212XL</td>
</tr>
</tbody>
</table>

Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the product until you are ready to replace them to prevent the print head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Note: If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

1. Turn on your product.
   - If an ink cartridge is expended, you see a message on the LCD screen. Note which cartridges need to be replaced and select Replace now.
   - If you are replacing a cartridge before you see a message on the LCD screen, press the home button if necessary, select Maintenance > Ink Cartridge(s) Replacement, and follow the instructions on the LCD screen.
2. Lift up the scanner unit until it locks into place.

**Caution:** Do not move the print head by hand; otherwise, you may damage your product. Do not touch the flat white cable or translucent film inside the product.
3. Squeeze the tab on the cartridge and lift the cartridge straight up to remove it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

4. If you are replacing the black ink cartridge, gently shake the new black ink cartridge four or five times. Do not shake the color ink cartridges.
Caution: Do not shake the cartridges after opening the packages, or ink may leak.

5. Remove the cartridge from the package.

Caution: Do not touch the areas shown here. Doing so may prevent normal operation and printing.
6. Remove the yellow tape from the cartridge.

**Caution:** Do not remove any other labels or seals, or the ink cartridge may leak or become unusable.

7. Insert the new cartridge into the holder and push it down until it clicks into place.
8. When you finish replacing the cartridges, lift the scanner unit up slightly and lower it. When the scanner unit catches, lift it up again and lower it completely.

9. Press the **OK** button when you are done.
   
   The print head moves to its home position and the product starts charging the ink. This takes a few minutes. When you see a completion message on the screen, ink replacement is finished.

   **Caution:** Do not turn off the product while ink is charging or you may not be able to print.

   **Caution:** If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. The valve in the ink supply port is designed to contain any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related concepts

Purchase Epson Ink Cartridges and Maintenance Box

Printing with Black Ink and Expended Color Cartridges

When a color ink cartridge is expended, you can temporarily continue printing using black ink. Replace the expended color cartridge as soon as possible for future printing.

Printing with Expended Color Cartridges - Control Panel
Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - Control Panel

If you see a message on the control panel to replace a color ink cartridge, you can temporarily print or copy in black ink.

Note the following restrictions when using this feature:

• You can print or copy only on plain paper or envelopes
• You can print or copy only in black or grayscale
• You cannot select borderless printing or copying

1. When you see a message on the LCD screen to replace a color ink cartridge, select Proceed.
   You see a message that you can temporarily print with black ink.

2. Select Proceed again.

3. If you want to print or copy in black only, select Remind me later.
   The current print job is canceled.

4. Press the home button, if necessary.

5. Try printing or copying again.

Parent topic: Printing with Black Ink and Expended Color Cartridges

Printing with Expended Color Cartridges - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an expended color cartridge, you can cancel your print job and select settings to print on plain paper or on an envelope.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Note: To use this feature, Epson Status Monitor must be enabled.
1. Click **Cancel** or **Cancel Print** to cancel your print job.

   **Note:** If the message screen appears on another computer on a network, you may need to cancel the print job using the product control panel.

2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the **Main** tab and make sure **Borderless** is not selected.
5. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
6. Select the **Black/Grayscale** checkbox.
7. Click **OK**.
8. Print your document.
   Epson Status Monitor 3 displays a print message.
9. Click **Print in Black** to print your document.

**Parent topic:** Printing with Black Ink and Expended Color Cartridges

---

### Printing with Expended Color Cartridges - Mac

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink on plain paper or on an envelope.

1. Click the printer icon in the Dock.
2. If you see a message telling you that you can temporarily print with only black ink, click the **Delete** or **button to cancel your print job. If you see an error message, click **OK**.

   **Note:** If the message screen appears on another computer on a network, you may need to cancel the print job using the product control panel.

3. In the Apple menu or the Dock, select **System Preferences**.
4. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
5. Select **Driver** or **Options**.
You see a screen like this:

![Screen with options]

6. Select **On** as the **Permit temporary black printing** setting.
7. Click **OK**.
8. Close the utility window.
9. Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
11. Select **Print Settings** from the pop-up menu.
12. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
13. Select the **Grayscale** option.
14. Click **Print** to print your document.

**Parent topic:** Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

The following window appears when black ink runs low and there is more color ink.

![EPSON Status Monitor 3](image)

**Note:** The window appears only when you have selected **Plain Paper/Bright White Paper** as the paper type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor must be enabled.

- Click **Yes** to use a mixture of color inks to create black, or **No** to continue using the remaining black ink for the document you are printing.
- Click **Disable this feature** to continue using the remaining black ink.

**Note:** If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Maintenance Box Replacement

The maintenance box stores surplus ink that gets flushed from the system during print head cleaning. When you see a message on the LCD screen, follow the on-screen instructions to replace the maintenance box.

Note the following precautions when replacing the maintenance box:

- Do not remove the maintenance box or its cover except when replacing the maintenance box; otherwise, ink may leak.
• Do not touch the areas of the maintenance box or inside the product as shown below.

![Diagram of maintenance box areas not to touch]

• Do not touch the green chip on the side of the maintenance box.
• Do not tilt the maintenance box after removing it or ink may leak.
• Do not touch the openings in the maintenance box or you may get ink on you.
• Do not drop the maintenance box or subject it to strong shocks.
• If you cannot replace the cover, the maintenance box may not be installed correctly. Remove and reinstall the maintenance box.
• Do not store the maintenance box in high or freezing temperatures.
• Do not replace the maintenance box during printing; otherwise, ink may leak.
• Keep the maintenance box out of direct sunlight.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for a long period. Keep the maintenance box away from direct sunlight.

Note: The maintenance box is a user-replaceable part and is not covered by the product warranty.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

- **Print Head Maintenance**
- **Aligning the Print Head Using the Product Control Panel**
- **Cleaning the Paper Guide**

**Print Head Maintenance**

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

- **Print Head Nozzle Check**
- **Print Head Cleaning**

**Parent topic:** Adjusting Print Quality

**Related concepts**

- **Purchase Epson Ink Cartridges and Maintenance Box**

**Related topics**

- **Replacing Ink Cartridges and Maintenance Boxes**

**Print Head Nozzle Check**

You can print a nozzle check pattern to check for clogged nozzles.

- **Checking the Nozzles Using the Product Control Panel**
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Maintenance > Nozzle Check.

   You see a screen like this:

   ![Screen showing Nozzle Check]

5. Press the start button to print.
   
The nozzle pattern prints.
6. Check the printed pattern to see if there are gaps in the lines.
   
   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

7. Do one of the following:
   
   • If there are no gaps, select **No**.
   • If there are gaps or the pattern is faint, select **Yes** and continue.

8. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the process as necessary.

   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing or longer if printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Nozzle Check

**Related tasks**

Cleaning the Print Head Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   - **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
4. Select **Nozzle Check**.
   You see a window like this:
5. Click **Print**.
6. Check the printed pattern to see if there are gaps in the lines.
   
   **Print head is clean**
   
   ![Print head is clean image]

   **Print head needs cleaning**
   
   ![Print head needs cleaning image]

7. If there are no gaps, click **Finish**.  
   If there are gaps or the pattern is faint, clean the print head.

**Parent topic:** Print Head Nozzle Check

**Related tasks**

- [Cleaning the Print Head Using a Computer Utility](#)
- [Checking the Nozzles Using the Product Control Panel](#)

**Print Head Cleaning**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.
Cleaning the Print Head Using the Product Control Panel

You can clean the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select **Maintenance > Head Cleaning**.
   
   You see a screen like this:

   ![Clean print head to correct missing dots.](image)

5. Press the start button to start cleaning the print head.

   When the cleaning cycle is finished, you see a message on the screen.

   **Caution:** Never turn off the product or open the front cover during a cleaning cycle or you may not be able to print.

6. Select **Nozzle Check**.
7. Select **Finish** to confirm that the print head is clean.
8. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean](image)

   **Print head needs cleaning**

   ![Print head needs cleaning](image)

9. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the process as necessary.

   If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing or longer if printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

**Parent topic:** Print Head Cleaning

**Related tasks**
- **Cleaning the Print Head Using a Computer Utility**
- **Checking the Nozzles Using the Product Control Panel**

**Cleaning the Print Head Using a Computer Utility**

You can clean the print head using a utility on your Windows or Mac computer.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   - **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   - **Mac**: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

4. Select **Head Cleaning**.
   You see a window like this:

   ![Head Cleaning window](image)

   **Click [Start]** to clean the print head nozzles. Because cleaning consumes some ink, only clean the print head when faint areas or gaps appear in your printout. Use the "Nozzle Check" utility first to confirm that the print head needs to be cleaned.

5. Click **Start** to begin the cleaning cycle.
   The ✪ power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is finished.

   **Caution**: Never turn off the product during a cleaning cycle or you may damage it.
6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.

7. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean]

   **Print head needs cleaning**

   ![Print head needs cleaning]

   - If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don't see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

**Parent topic:** [Print Head Cleaning](#)

**Related tasks**
- [Cleaning the Print Head Using the Product Control Panel](#)
- [Checking the Nozzles Using a Computer Utility](#)

### Aligning the Print Head Using the Product Control Panel

You can align the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Maintenance > Print Head Alignment.
   You see a screen like this:

   ![Print Head Alignment Screen]

5. Select one of the following options:
   - **Vertical Alignment** if your printout is blurry.
   - **Horizontal Alignment** if your printout contains horizontal banding.
6. Follow the on-screen instructions to print an alignment sheet.
   
   **Note:** Do not cancel printing while you are printing head alignment patterns.

7. Check the printed patterns on the alignment sheet and select the following on the LCD screen, depending on the alignment pattern you printed:
   - **Vertical Alignment:** For each pattern, select the number representing the pattern with the least amount of separation or overlap.

   ![Pattern Examples]
• **Horizontal Alignment**: Select the number representing the pattern with the least amount of separation or overlap.

8. **Select Dismiss**.

**Parent topic**: Adjusting Print Quality

**Cleaning the Paper Guide**

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.

1. If printouts are smeared or scuffed, load a few sheets of plain paper in this size: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

2. Make sure there are no errors on the LCD screen.

3. Press the home button, if necessary.

4. Select **Maintenance > Paper Guide Cleaning**.

   You see a screen like this:
5. Press the start button to start cleaning the paper guide.
6. Repeat these steps as necessary until the paper comes out clean.

**Parent topic:** Adjusting Print Quality
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Cleaning the Print Head Path
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cord.
3. Disconnect any connected cables.
4. Pull out the paper cassette and remove the paper.
5. Open the document cover.
6. Clean the scanner glass and the areas shown below with a soft, lint-free cloth (microfiber is recommended) moistened with a little glass cleaner.

**Caution:** Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.

7. Close the document cover.
8. Open the ADF cover.
9. Use a soft, lint-free cloth (microfiber is recommended) moistened with a little water to clean the rollers and the interior of the ADF.

**Caution:** Do not use a dry cloth to clean the rollers; you may damage them.

10. Open the ADF input tray.
11. Clean the area shown here.

12. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.

**Parent topic:** Cleaning and Transporting Your Product

**Cleaning the Print Head Path**

If the print quality has not improved after aligning the print head and cleaning the paper guide, the print head path inside the product may be smeared with ink.

To clean the print head path, use the following:

- Several cotton swabs
- ¼ cup (59 ml) water containing 2 to 3 drops of mild dish detergent
- A small flashlight

**Caution:** Do not use any other liquid to clean the print head path or you may damage your product.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Lift up the scanner unit.

5. Using the flashlight, check the translucent film shown here for ink smears.
1. Translucent film
2. Print head rail (do not touch)

**Caution:** Do not touch the flat white cable or the print head rail; otherwise, you may not be able to print. Do not wipe off the grease on the rail.

6. Moisten a cotton swab with the water and detergent mixture and squeeze out any excess moisture. Use it to lightly wipe ink off the translucent film.

![Image of a cotton swab against a background of a circuit board]

**Caution:** Do not press too hard on the film or you may dislocate the anchor springs and damage the product.

7. Use a new, dry cotton swab to dry the translucent film.
8. Repeat steps 6 and 7 as necessary to clean all ink smears.
9. When the translucent film is dry, close the scanner unit.
10. Plug in the power cable and reconnect any interface cables.

**Parent topic:** Cleaning and Transporting Your Product

**Transporting Your Product**

If you need to store your product or transport it a long distance, prepare it for transportation as described here.
Caution: During transportation and storage, follow these guidelines:

• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product from printing.
• Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Wait for the power light to go out, then unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper from the product.
5. Lift up the scanner unit and check to see if the print head is in the far right position (the home position). If not, turn on the product, wait for the print head to move, then turn the product off again.

Caution: Do not touch the flat white cable inside the product.
7. Close the scanner unit.

8. Close the output tray and paper support, lower the control panel, and close the rear feed.

9. Place the product in its original packing materials, if possible, or use equivalent materials with cushioning around the product. Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder before turning on your product. If print quality has declined when you print again, clean and align the print head.

**Parent topic:** Cleaning and Transporting Your Product

**Related concepts**

Print Head Nozzle Check
Print Head Cleaning
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Viewing Help Topics
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Faxing Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software. Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Note: Epson periodically provides firmware updates to address issues of security, performance, minor bug fixes and ensure your printer functions as designed. Your printer was designed to work only with genuine Epson ink cartridges, therefore some updates may affect the functionality of third-party ink.
• **Windows**: Your printer software automatically checks for updates. You can also manually update the software by selecting **Software Update** here:

• Accessing the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking .

• On the **Maintenance** tab in the printer settings window

You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

• **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

• **macOS 10.12.x, 10.13.x, or 10.14.x**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

**Parent topic:** [Solving Problems](#)

### Viewing Help Topics

You can view troubleshooting or how-to topics or animations on the LCD screen at any time.

1. Press the 📖 help button.

   You see this screen:

   ![Help Screen](image)

2. Select **Troubleshooting** or **How To** and follow the on-screen instructions to view instructions or animations.
Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen.

**Note:** If the LCD screen is dark, press any button on the control panel to wake the product from sleep mode.

<table>
<thead>
<tr>
<th>LCD code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(E-01)</td>
<td>A printer error has occurred. Turn the product off and then back on again. If the error continues, check for a paper jam. If there is no paper jam, contact Epson for support.</td>
</tr>
<tr>
<td>(E-02)</td>
<td>A scanner error has occurred. Turn the product off and then back on again.</td>
</tr>
<tr>
<td>(E-12)</td>
<td>A borderless printing ink pad needs to be replaced. Contact Epson for support. Borderless printing is not available, but printing with a border is available.</td>
</tr>
<tr>
<td>(W-01)</td>
<td>Paper is jammed in the product. Remove the jammed paper, then press the button indicated on the LCD screen to clear the error. If the error continues, turn the product off and back on again.</td>
</tr>
<tr>
<td>(W-12)</td>
<td>An ink cartridge is installed incorrectly. Press down each ink cartridge to make sure it is firmly installed.</td>
</tr>
<tr>
<td>(W-13)</td>
<td>The ink cartridge displayed on the LCD screen is not recognized by your product. Make sure you installed genuine Epson ink cartridges.</td>
</tr>
<tr>
<td>(W-14)</td>
<td>A borderless printing ink pad is nearing the end of its service life. Contact Epson for support. (To continue printing, press the start button.)</td>
</tr>
<tr>
<td>(I-22)</td>
<td>To establish a wireless connection using a router or access point, press the button on the router or access point, or click the button on its wireless settings screen displayed on your computer.</td>
</tr>
<tr>
<td>(I-23)</td>
<td>Enter the PIN code displayed on the LCD screen into the router, access point, or computer within two minutes. If you wait longer than two minutes, a time-out error occurs, the code changes, and you must enter a new code.</td>
</tr>
<tr>
<td>(I-31)</td>
<td>To make wireless connection settings from your computer, run the installer and follow the on-screen instructions.</td>
</tr>
<tr>
<td>(I-41)</td>
<td>The <strong>Paper Setup Auto Display</strong> option is disabled. You must enable <strong>Paper Setup Auto Display</strong> to use AirPrint.</td>
</tr>
<tr>
<td>LCD code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>(I-60)</td>
<td>Your computer may not support WSD (Web Services for Devices). The Scan to PC (WSD) function is available only for computers running English versions of Windows 10, Windows 8.x, Windows 7, or Windows Vista. Make sure your product is connected correctly to the computer.</td>
</tr>
<tr>
<td>Recovery Mode</td>
<td>A firmware update has failed. Connect your product using a USB cable and try updating the firmware again. If you still receive this error message, contact Epson for support.</td>
</tr>
</tbody>
</table>

**Note:** The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages. During the life of your product it may reach a condition where either satisfactory print quality cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your LCD screen, or lights on the control panel will advise you when these parts need replacing. If this happens during the standard warranty of the product, the exchange of the product or replacement of the pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

**Parent topic:** Solving Problems

**Related references**
- Where to Get Help
- Paper Source Settings Options

**Related tasks**
- Using AirPrint
- Selecting the Line Type
- Accessing the Web Config Utility
- Checking for Software Updates

**Related topics**
- Replacing Ink Cartridges and Maintenance Boxes
- Wi-Fi or Wired Networking

### Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select **Maintenance > Nozzle Check**.
   You see a screen like this:

```
<table>
<thead>
<tr>
<th>Load Letter/A4 size plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
</tr>
<tr>
<td>Print</td>
</tr>
</tbody>
</table>
```

5. Press the start button.
   The nozzle pattern prints.
6. Do one of the following, depending on the results of the product check:
   - If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.
   - If the page prints but the nozzle check pattern has gaps, clean the print head.
   - If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

**Parent topic:** Solving Problems

**Related concepts**
- Print Head Cleaning
- Uninstall Your Product Software

**Related references**
- Where to Get Help
Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

1. Press the home button, if necessary.
2. Select Settings > Restore Default Settings.
   
   You see a screen like this:

   ![Network Settings Screen]

3. Select one of these options:
   
   - **Network Settings**: Resets all network settings
   - **Copy Settings**: Resets all settings for copying
   - **Scan Settings**: Resets all settings for scanning
   - **Fax Settings**: Resets all settings for faxing
   - **Clear All Data and Settings**: Resets all control panel settings including the contacts list

   You see a confirmation screen.

4. Press the OK button to reset the selected settings. (Press the cancel button if you want to cancel the operation.)

   **Parent topic**: Solving Problems

Solving Setup Problems

Check these sections if you have problems while setting up your product.
Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

• If you cannot turn on your product, make sure the power cord is securely connected and hold down the power button a little longer.

• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off your product, unplug the power cord, plug the power cord back in, then turn your product on and off again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation

If you hear noises from your product after installing ink, check the following:

• The first time you install the ink cartridges, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on.

• If the product's print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems

If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions on the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.
• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac Printer Window
Wireless Network Connection is Unstable on a Mac
Cannot Print Over a Network
Cannot Scan Over a Network

Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.
Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- Verify that your router or access point is operating correctly by connecting to it from your computer or another device.
- Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
- You may need to disable the firewall and any anti-virus software on your wireless router or access point.
- Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you restart your router.

- Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router's address list. To obtain your product's MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.
- If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.
- If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.
- Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.
- If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the maximum number of devices connected to your product (8). Print a network status sheet or access Web Config on the browser for your device and check the number of connected devices. If 8 devices are already connected, disconnect a device by deleting the product's SSID from the Wi-Fi screen of that device. If fewer than 8 devices are connected, check the accuracy of your other network settings, move your device closer to your product, and try connecting again.
- If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.
• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the network connection or adapter settings in the Windows Control Panel and set the Internet metric setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related tasks
Enabling Wi-Fi Direct Mode
Printing a Network Status Sheet
Printing a Network Connection Report

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify the connection using your product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.
• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product's network settings to their factory defaults.
  2. Windows only: Uninstall your product software.
  3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here sheet.
• If you have replaced your router, reinstall your product software to connect to the new router.
Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Connection Report

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in Mac Printer Window

If your product does not appear in the Mac printer window, try these solutions:

- Turn your product off, wait 30 seconds, then turn it back on again.
- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.
- If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna icon with connection bars on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related tasks
Uninstalling Product Software - Mac
Wireless Network Connection is Unstable on a Mac

If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network interference between your product and your Mac.

If you cannot connect to your product over the wireless network or the connection becomes unstable, move the device connected to your Mac USB 3.0 port further away from your Mac.

Parent topic: Solving Network Problems

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is **Disconnected**, check any cable connections and turn your product off and then on again.
• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

• Try restarting your router following the instructions in your router documentation.

  **Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check if there are any paused print jobs.
• Make sure your printer is selected as the default printer.
• Check if the selected printer port is correct.
• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  • Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  • Try connecting your product to a different port or a different router, access point, switch, or hub.
  • Try connecting with a different Ethernet cable.
  • Try printing to your product from another computer on the network.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Status Sheet
Printing a Network Connection Report

Related topics
Wi-Fi or Wired Networking

**Cannot Scan Over a Network**

If you cannot start Epson Scan 2 for scanning over a network, try these solutions:

• If you cannot scan from your product control panel, make sure you restarted your computer after installing the product software. Make sure the Event Manager program is not being blocked by your firewall or security software.
Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.
- If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try restarting Epson Scan 2 again.
- Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:
  - **Windows 10**: Click and select **EPSON > Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.
  - **Windows 8.x**: Navigate to the **Apps** screen, select **EPSON**, and select **Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.
  - **Windows (other versions)**: Click or **Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.
  - **Mac**: Open the **Applications** folder, click **Epson Software**, and click **Epson Scan 2 Utility**. Make sure your product is selected. If necessary, select the **Other** tab and click **Reset**.
- You may need to disable the firewall and any anti-virus software on your wireless router or access point.

Parent topic: Solving Network Problems
Related tasks
Starting a Scan Using the Product Control Panel

Solving Copying Problems
Check these solutions if you have problems copying with your product.

- **Product Makes Noise, But Nothing Copies**
- **Product Makes Noise When It Sits for a While**
- **Originals Do Not Feed From the Automatic Document Feeder**

Parent topic: Solving Problems
Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
• Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder
If your originals do not feed when placed in the ADF, try these solutions:

• Make sure the ADF icon lights up on the Copy, Fax, or Scan screen on the LCD screen. If not, reload the originals.
• Make sure the size, weight, and number of your originals are supported by the ADF.
• Make sure the originals are loaded correctly.
• Make sure the document is not curled or creased.
• Try cleaning the inside of the ADF.
• Do not load originals above the arrow mark on the ADF edge guide.

Parent topic: Solving Copying Problems
Related references
Document Jams in the Automatic Document Feeder
ADF Original Document Specifications
Related tasks
Placing Originals in the Automatic Document Feeder
Cleaning Your Product

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover
Document Jams in the Automatic Document Feeder
Paper Ejection Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• Place the product on a flat surface.
• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feed. Slide the edge guides against the edge of the paper, making sure that the paper stack is not above the arrow mark on the edge guides.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• Make sure the paper size and paper type settings on the control panel are correct.
• Try cleaning the paper path.
• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
  • Load paper in the rear paper feed printable side up.
  • Follow any special loading instructions that came with the paper.
• When loading originals in the ADF, load them in the correct direction and not above the arrow on the ADF edge guide. Load only originals supported by the ADF and be sure to slide the ADF edge guide against the edge of the originals. Check that the ADF icon appears on the Copy, Scan, or Fax screen; if not, remove and replace the originals.
• Clean the inside of the ADF.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover
Document Jams in the Automatic Document Feeder
Paper Specifications

Related tasks
Cleaning the Print Head Path
Cleaning Your Product
Cleaning the Paper Guide
Paper Jam Problems Inside the Product

If you see a message on the LCD screen that paper has jammed inside the product, follow the steps here or on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove the jammed paper from the rear feed.

3. Open the scanner unit.
4. Carefully remove any paper jammed inside the product.

**Note:** Do not touch the flat white cable or translucent film inside the product.
5. Close the scanner unit.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Rear Cover
Document Jams in the Automatic Document Feeder

Paper Jam Problems in the Rear Cover

If paper has jammed in the rear cover, follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Squeeze the tabs and remove the rear cover.

3. Carefully remove any jammed paper from inside the product.
4. Carefully remove any jammed paper from the duplexer.

5. Replace the rear cover.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Document Jams in the Automatic Document Feeder

Document Jams in the Automatic Document Feeder

If you have problems with document jams in the automatic document feeder (ADF), follow the steps here to clear the jam.

1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Open the ADF cover.

4. Carefully remove any jammed pages from beneath the ADF.

5. Raise the ADF input tray.
Note: Make sure the ADF cover is opened before raising the ADF input tray.

6. Remove the jammed paper.

7. Lower the ADF input tray.
8. Close the ADF cover until you hear a click.

9. Reload your originals.

   **Caution:** Make sure you do not load the ADF beyond its capacity for your paper size. Also make sure your originals are not bent, folded, or curled and do not have tape, staples, or other materials that could obstruct the feeder.

10. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

**Parent topic:** Solving Paper Problems

**Related references**

- Paper Jam Problems Inside the Product
- Paper Jam Problems in the Rear Cover
- ADF Original Document Specifications

**Related tasks**

- Placing Originals in the Automatic Document Feeder

**Paper Ejection Problems**

If you have problems with paper ejecting properly, try these solutions:

- If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.

- If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.
Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

- Make sure your product is turned on and connected to your computer.
- Make sure any interface cables are connected securely at both ends.
- If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
- Make sure the printer status is not offline or pending.
- Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system's memory.
- In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.
- In Windows, delete all jobs from the Windows Spooler. Click **Print Queue** on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.

**Note:** When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.
• On a Mac, make sure the printer is added to the printer list and the printer is not paused.

**Parent topic:** Solving Problems Printing from a Computer

**Related references**

Windows System Requirements
Mac System Requirements

**Related tasks**

Running a Product Check

### Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:

   • **Windows 10:** Click  and select (Settings) > Devices > Printers & scanners. Select your product name and select **Manage** > **Printing preferences**.

   • **Windows 8.x:** Navigate to the Apps screen and select **Control Panel** > **Hardware and Sound** > **Devices and Printers**. Right-click your product name, select **Printing Preferences**, and select your product name again if necessary.

   • **Windows 7:** Click and select **Devices and Printers**. Right-click your product name, select **Printing Preferences**, and select your product name again if necessary.

   • **Windows Vista:** Click , select **Control Panel**, and click Printer under **Hardware and Sound**. Right-click your product name, select **Printing Preferences**, and select your product name again if necessary.

2. Click the **Maintenance** tab.

3. Click the **Extended Settings** button.

4. Select **Enable EPSON Status Monitor 3** and click **OK**.

5. Click the **Monitoring Preferences** button.

6. Click the checkbox for the option that adds the shortcut icon to the taskbar.

7. Click **OK** to close the open program windows.

**Parent topic:** Solving Problems Printing from a Computer
Printing is Slow

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.
- If you are using Windows 7, close the Devices and Printers window before you print.
- On a Mac, make sure you download and install the Epson printer driver.
- Make sure Quiet Mode is turned off.
- Clear space on your hard drive or run a defragmentation utility to free up existing space.
- Close any programs you are not using when you print.
- If your product is connected to a USB hub, connect it directly to your computer instead.
- If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.
- If you are printing over a wireless network, factors such as interference, network traffic, or weak signal strength may affect your printing speed.

For the fastest printing, select the following settings in your product software:

- Make sure the paper type setting matches the type of paper you loaded.
- Turn on any high speed settings in your product software.
- Select a lower print quality setting.
- Make sure the ink drying time has not been increased for double-sided printing.
- **Windows**: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress, and select the following settings:
  - Always Spool RAW Datatype
  - Page Rendering Mode
  - Print as Bitmap

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders: ProgramData > EPSON > PRINTER.
Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and search options. In the window that appears, click the View tab, select Show hidden files, folders, and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.

Parent topic: Solving Problems Printing from a Computer

Related references
Paper or Media Type Settings - Printing Software
Windows System Requirements
Mac System Requirements

Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems
Related tasks
Using AirPrint
Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

- Turn off any mirror or inversion settings in your printing application.
- Turn off the **Mirror Image**, **Flip horizontally**, or **Reverse page orientation** settings in your printer software. (This option has different names, depending on your operating system version.)

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- Selecting Additional Layout and Print Options - Windows
- Selecting Basic Print Settings - Windows

Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the **Skip Blank Page** setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.

**Parent topic:** Solving Page Layout and Content Problems

**Related concepts**

- Print Head Nozzle Check

**Related tasks**

- Selecting Basic Print Settings - Windows
Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Incorrect Characters Print

If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer exits sleep mode may contain garbled characters. Print your document again.

Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position

If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
• Clean the scanner glass and document cover.
• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner glass.

You can use the preview option in your printer software to check your margins before you print.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Additional Layout and Print Options - Windows
- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac
- Cleaning Your Product

### Slanted Printout

If your printouts are slanted, try these solutions:

• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac
- Aligning the Print Head Using the Product Control Panel

### Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

**Note:** When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors

Parent topic: Solving Problems

Related tasks
Using AirPrint

White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- Turn off any high speed settings in your product software.
- Align the print head.
- You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Aligning the Print Head Using the Product Control Panel
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac

Related topics
Replacing Ink Cartridges and Maintenance Boxes
Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:

- Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
- Use a support sheet with special paper, or load special paper one sheet at a time.
- Make sure your paper meets the specifications for your product.
- Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
- Make sure the paper type setting in your product software matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- Remove each sheet from the output tray as it is printed.
- Avoid handling printouts on glossy paper right after printing to allow the ink to set.
- Turn off any high speed settings in your product software.
- If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density and/or ink drying time settings.
- If printed copies are smeared, lower the copy density setting on the product control panel.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Align the print head.
- Clean the paper path.
- Clean the scanner glass.
- Clean the ADF.

**Note:** Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

- Print Head Nozzle Check
- Print Head Cleaning
Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Aligning the Print Head Using the Product Control Panel
Cleaning the Paper Guide
Cleaning the Print Head Path

Related topics
Replacing Ink Cartridges and Maintenance Boxes
**Grainy Printout**

If your printouts are grainy, try these solutions:

- Make sure you loaded the printable side of the paper correctly for your product.
- Select a higher print quality setting and turn off any high speed settings in your product software.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Align the print head.
- You may need to increase the image resolution or print a smaller size; see your software documentation.

**Note:** Images from the Internet may be low resolution and not result in a high quality printout.

- If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.

**Note:** Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Nozzle Check
- Print Head Cleaning

**Related tasks**
- Aligning the Print Head Using the Product Control Panel
- Selecting Basic Print Settings - Windows
- Selecting Additional Layout and Print Options - Windows
- Selecting Basic Print Settings - Mac
- Selecting Printing Preferences - Mac
Incorrect Colors

If your printouts have incorrect colors, try these solutions:

- Make sure the paper type setting matches the paper you loaded.
- Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
- If you selected Standard-Vivid (Windows) or Normal-Vivid (Mac) as the quality setting in the printer software, try selecting Standard (Windows) or Normal (Mac) instead.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- The ink cartridges may be old or low on ink, and you may need to replace them.
- After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
- For best results, use genuine Epson paper.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Compatible Epson Papers

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Managing Color - Mac

Related topics
Replacing Ink Cartridges and Maintenance Boxes
Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Scanning is Slow
Cannot Save a Scan to a Shared Folder Over a Network

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control panel.
• If you are scanning with the ADF, make sure the ADF and document covers are closed.

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• If you are scanning with the ADF, check that the document cover and ADF cover are closed.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.

• Check the connection setting and test the connection using Epson Scan 2 Utility:

   **Windows 10:** Click ☐ and select EPSON > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

   **Windows 8.x:** Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

   **Windows (other versions):** Click or Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

   **Mac:** Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both versions and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.

**Parent topic:** Solving Scanning Problems

**Related concepts**

Uninstall Your Product Software

---

**Scanning is Slow**

If scanning becomes slow, try these solutions:

• Scan your original at a lower resolution, if possible.

• Make sure your system meets the requirements for your operating system. If you are scanning a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory or reduce the resolution.

• In Epson Scan 2, turn off Quiet Mode on the Scan tab.

• If you are scanning over a wireless network, factors such as interference, network traffic, or weak signal strength may affect your scanning speed.

**Parent topic:** Solving Scanning Problems

**Related topics**

Wi-Fi or Wired Networking
Cannot Save a Scan to a Shared Folder Over a Network

If you cannot save a scan to a shared folder when scanning over a network, or saving takes a very long time, try these solutions:

• If you cannot scan to a shared folder over the network, make sure you did the following:
  • Created a shared folder on your computer (Windows).
  • If you registered the shared folder path to your product's control panel contact list or entered the path manually to scan, make sure you used the correct path.
  • Make sure the network folder does not already contain a file of the same name. If so, rename the file and try again.
  • If you still cannot scan to the shared folder, your network type may be set to Public. You cannot scan to a shared folder when using a public network. Follow the steps here to check and change your network type, if necessary. Be sure to log into your Windows computer as an administrator.

  Note: The name of available network types varies in the different Windows versions. For details on selecting Windows network sharing settings, see Windows help.

Windows 10:

1. Click \[\text{Settings} \] and select \text{Settings}.
2. Select \text{Network & Internet}.
3. Click your network type: \text{Ethernet} or \text{Wi-Fi}.
4. Click your network name.
5. Make sure the \text{Make this PC discoverable} setting is set to \text{On}. Select this setting when connected to a private network so you can save a scan to a shared folder. If you select \text{Off}, you cannot save your scan to a shared folder on a private network.

Windows 8.1:

1. At the Start screen, type \text{PC Settings} to automatically search the system.
2. Click \text{Network} in the PC Settings window.
3. Click your network name.
4. Make sure \text{Find devices and content} is set to \text{On}. Select this setting when connected to a private network so you can save a scan to a shared folder. If you select \text{Off}, you cannot save your scan to a shared folder on a private network.
**Windows 8.0:**
1. At the Start screen, type **Settings** to automatically search the system.
2. Select **Settings** when it appears and type **Network** into the search field.
3. Right-click your network name in the window that appears and click **Turn sharing on or off**.
4. When you see this message, select **Yes**:
   
   **Do you want to turn on sharing between the PCs and connect to devices on this network?**
   
   Select this setting when connected to a private network so you can save a scan to a shared folder. If you select **No**, you cannot save your scan to a shared folder on a private network.

**Windows 7:**
1. Click ☌️ or press the Windows key on your keyboard.
2. Type **Network and Sharing Center** into the search field.
3. Under View your active networks, make sure **Home network** or **Work network** is selected when connected to a private network so you can save a scan to a shared folder. (If you need to change the network type, click the network type name.) If you select **Public network**, you cannot save a scan to a shared folder.
   
   • If saving your scan to a shared folder takes a very long time, make sure the DNS setting and the DNS domain name are correct. Contact your network administrator for instructions.

**Parent topic:** Solving Scanning Problems

**Solving Scanned Image Quality Problems**

Check these sections if a scanned image on your computer screen has a quality problem.

- **Image Consists of a Few Dots Only**
- **Line of Dots Appears in All Scanned Images**
- **Straight Lines in an Image Appear Crooked**
- **Image is Distorted or Blurry**
- **Image Colors are Patchy at the Edges**
- **Image is Too Dark**
- **Back of Original Image Appears in Scanned Image**
- **Ripple Patterns Appear in an Image**
- **Scanned Image Colors Do Not Match Original Colors**
- **Scanned Image Edges are Cropped**
Parent topic: Solving Problems

Image Consists of a Few Dots Only

If your scanned image consists only of a few dots, try these solutions:

- Make sure you placed your original for scanning facing the correct way.
- If the Image Type setting is Black & White, adjust the Threshold and scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

If you are scanning from the ADF, try cleaning the ADF and scan again.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.

If you are scanning from the ADF, try cleaning the ADF and scan again.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Related topics
Placing Originals on the Product
**Image is Distorted or Blurry**

If a scanned image appears distorted or blurry, try these solutions:

- Do not move your original or your product during scanning.
- Your product will not operate properly while tilted at an angle. Place your product on a flat, stable surface that extends beyond its base in all directions.
- Adjust these Epson Scan 2 settings (if available) and try scanning again:
  - Increase the **Resolution** setting.
  - If the **Image Type** setting is **Black & White**, adjust the **Threshold** setting.
  - If the **Image Type** setting is **Color** or **Grayscale**, select the **Unsharp Mask** setting.
  - If the **Image Type** setting is **Black & White**, select **Text Enhancement**. If the **Image Type** setting is **Color** or **Grayscale**, change the **Text Enhancement** setting to **High**.

Parent topic: Solving Scanned Image Quality Problems

**Related references**

Additional Scanning Settings - Advanced Settings Tab

---

**Image Colors are Patchy at the Edges**

If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.

Parent topic: Solving Scanned Image Quality Problems

---

**Image is Too Dark**

If your scanned image is too dark, try these solutions:

- If the **Image Type** is set to **Color** or **Grayscale**, adjust the **Brightness** setting.
- Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

**Related references**

Additional Scanning Settings - Advanced Settings Tab

---

**Back of Original Image Appears in Scanned Image**

If an image from the back of a thin original appears in your scanned image, try these solutions:

- Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the **Advanced Settings** tab and adjust the **Brightness** setting.
  • Select **Text Enhancement**.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

### Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the **Descreening** setting.
• Select a lower **Resolution** setting.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab

### Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try scanning again:

• If the **Image Type** setting is **Color** or **Grayscale**, adjust the **Contrast** setting.
• If the **Image Type** setting is **Black & White** or **Grayscale**, adjust the **Color Enhance** setting.

Parent topic: Solving Scanned Image Quality Problems

Related references
Additional Scanning Settings - Advanced Settings Tab
Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Solving Faxing Problems

Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product
Fax Memory Full Error Appears
Sent Fax is Received in an Incorrect Size
Received Fax is Not Printed

Parent topic: Solving Problems

Cannot Send or Receive Faxes

If you cannot send or receive faxes, try these solutions:

• If you are faxing from a computer, use the Epson FAX Utility to send your fax.
• Make sure the recipient's fax machine is turned on and working.
• Make sure paper is loaded correctly in your product.
• Make sure you have set up your header information and have not blocked your caller ID. Otherwise, your faxes might be rejected by the recipient's fax machine.
• Make sure Receive Mode is set to Auto so you can receive faxes automatically.
• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
• Print a fax connection report using your product control panel or fax software to help diagnose the problem.
• Verify that the telephone wall jack works by connecting a phone to it and testing it.
• If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
product's dial tone detection setting. (Turning off the dial tone setting may cause the product to drop the first digit of a fax number.)

- If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to enable faxing over the line. Contact your DSL provider for the necessary filter.
- Make sure you installed the FAX driver for your product and that it is not paused.
- Try lowering your product's fax speed setting.
- Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a color fax.
- If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to prevent disruption of incoming faxes.
- If you have subscribed to a call forwarding service, the product may not be able to receive faxes. Contact your service provider for assistance.

**Note:** If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax transmission will work when using VoIP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received by your voice mail service.

**Parent topic:** Solving Faxing Problems

**Related tasks**

- Connecting a Telephone or Answering Machine
- Using the Fax Setup Wizard
- Selecting the Line Type
- Selecting Advanced Fax Settings
- Receiving Faxes Automatically
- Printing Fax Reports

### Cannot Receive Faxes with a Telephone Connected to Your Product

If you cannot receive faxes when a telephone is connected to your product, try these solutions:

- Make sure your telephone is connected to your product's **EXT** port.
- Make sure the Receive Mode is set to **Manual**.
Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard

Fax Memory Full Error Appears
If you see an error message telling you that the product's fax memory is full, try these solutions:

• If you set the product to save received faxes in the product's memory or inbox, delete any faxes you have already read.

  Note: Your product can store up to 100 faxes before its inbox is full.

• If you set the product to save received faxes on a computer, turn on the selected computer. Once the faxes are saved on the computer, they are deleted from the product's memory.

• If the memory is full, try the following:
  • Send a monochrome fax using the direct sending feature
  • Send your faxes in smaller batches

• If the product cannot print a received fax due to a product error, such as a paper jam, the memory full error may appear. Clear any product errors, then ask the sender to resend the fax.

Parent topic: Solving Faxing Problems

Related references
Fax Sending Options

Sent Fax is Received in an Incorrect Size
If your recipient receives a fax in an incorrect size, try these solutions:

• If you are sending a fax using the scanner glass, make sure your original is placed correctly and that the correct paper size is selected on the control panel.

• Clean the scanner glass and document cover.

Parent topic: Solving Faxing Problems
Related tasks
Cleaning Your Product

Received Fax is Not Printed
If a received fax is not printed, try these solutions:

- Make sure the product is free of errors. The product cannot print received faxes if an error has occurred with the product, such as a paper jam.
- If the product has been set to save received faxes in the product’s memory or inbox, received faxes are not automatically printed. Check the Receive Settings options on the product control panel and change them, if necessary.

Parent topic: Solving Faxing Problems

Related references
Receive Settings - Fax

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:
   - **Windows 10**: Click and select (Settings) > Apps or System > Apps & features. Then select the program you want to uninstall and select Uninstall.
   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

   **Note**: If you see a User Account Control window, click Yes or Continue.
Select your product again, if necessary, then select **OK**, and click **Yes** to confirm the uninstallation.

- **Windows (other versions):** Click **Start** or **Start**, and select **All Programs** or **Programs**. Select **EPSON**, select your product, then click **EPSON Printer Software Uninstall**.

  **Note:** If you see a **User Account Control** window, click **Yes** or **Continue**.

  In the next window, select your product and click **OK**. Then follow any on-screen instructions.

4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
   - **Windows 10/8.x:** Select **Epson Event Manager** and click **Uninstall**.
   - **Windows 7/Windows Vista:** Open the Windows **Control Panel** utility. Select **Programs and Features**. (In Classic view, select **Programs** and click **Uninstall a program**.) Select **Epson Event Manager** and click **Uninstall/Change**.

5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
   - **Windows 10:** Select **Epson Scan 2** and click **Uninstall**.
   - **Windows 8.x/Windows 7/Windows Vista:** Select **Epson Scan 2** and click **Uninstall/Change**.

6. Restart your computer, then see the **Start Here** sheet to re-install your software.

  **Note:** If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic:** Uninstall Your Product Software

## Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note:** If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.
2. Click **Downloads**.
3. Select your operating system, click **Utilities**, locate the Uninstaller utility, and click **Download**.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan, or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson’s support website at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Then call:
• U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

**Purchase Supplies and Accessories**

You can purchase genuine Epson ink and paper at [epson.com](https://epson.com) (U.S. sales), [epson.ca](https://epson.ca) (Canadian sales), or [epson.com.jm](https://epson.com.jm) (Caribbean sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

**Parent topic:** Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Automatic Document Feeder (ADF) Specifications
Scanning Specifications
Fax Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista

Note: For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.
Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

- macOS 10.14.x
- macOS 10.13.x
- macOS 10.12.x
- OS X 10.11.x
- OS X 10.10.x
- OS X 10.9.x
- OS X 10.8.x
- OS X 10.7.x
- OS X 10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select your product, and select Downloads.

Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
**Single-sheets**

**Size**
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- Legal (8.5 × 14 inches [216 × 356 mm])
- 8.5 × 13 inches (216 × 330 mm)
- Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
- Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
- Executive (7.25 × 10.5 inches [184 × 267 mm])
- 3.5 × 5 inches (89 × 127 mm)
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- Half Letter (5.5 × 8.5 inches [140 × 216 mm])

**Paper types**
- Plain paper

**Note:** Your product also supports compatible papers distributed by Epson. See the link at the end of this topic for a list of compatible Epson papers.

**Weight**
- Plain paper: 17 lb (64 g/m²) to 24 lb (90 g/m²)

**Envelopes**

**Size**
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

**Weight**
- 20 lb (75 g/m²) to 24 lb (90 g/m²)

Parent topic: Technical Specifications

**Printable Area Specifications**

**Note:** When printing borderless, quality may decline in the expanded printable area.
Single sheets

1. Top and sides: 0.12 inch (3 mm)
2. Reduced print quality area/top: 1.61 inches (41 mm)
3. Reduced print quality area/bottom: 1.46 inches (37 mm)

Borderless

1. Reduced print quality area/top: 1.73 inches (44 mm)
2. Reduced print quality area/bottom: 1.57 inches (40 mm)
Envelopes

1. Sides: 0.12 inch (3 mm)
2. Top/bottom: 0.20 inch (5 mm)
3. Reduced print quality area/right: 0.71 inch (18 mm)
4. Reduced print quality area/left: 1.61 inches (41 mm)

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Letter (8.5 × 11 inches [216 × 279 mm])</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
</tr>
<tr>
<td></td>
<td>8.5 × 13 inches (216 × 330 mm)</td>
</tr>
<tr>
<td>Paper type</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Paper weight</td>
<td>17 lb (64 g/m²) to 24 lb (95 g/m²)</td>
</tr>
</tbody>
</table>
Sheet feeding capacity

Total thickness: 0.13 inch (3.33 mm)
Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm]): approximately 30 sheets
Legal (8.5 × 14 inches [216 × 356 mm]) and 8.5 × 13 inches (216 × 330 mm): 10 sheets

Parent topic: Technical Specifications

Scanning Specifications

Scanner type
- Flatbed

Photoelectric device
- CIS

Effective pixels
- 10200 × 14040 pixels at 1200 dpi

Document size
- Maximum: 8.5 × 11.7 inches (216 × 297 mm)
- Scanner glass: US letter or A4

Scanning resolution
- 1200 dpi (main scan)
- 2400 dpi (sub scan)

Output resolution
- 50 to 9600 dpi in 1 dpi increments

Color depth
- Color:
  - 48 bits per pixel internal (16 bits per pixel per color internal)
  - 24 bits per pixel external (8 bits per pixel per color external)
- Grayscale:
  - 16 bits per pixel internal
  - 8 bits per pixel external
- Black and white:
  - 16 bits per pixel internal
  - 1 bit per pixel external

Light source
- LED

Parent topic: Technical Specifications
Fax Specifications

<table>
<thead>
<tr>
<th>Fax type</th>
<th>Black-and-white and color fax capability (ITU-T Super Group 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported lines</td>
<td>Standard analog (household) telephone lines</td>
</tr>
<tr>
<td></td>
<td>PBX (Private Branch Exchange) telephone systems</td>
</tr>
<tr>
<td>Speed</td>
<td>Up to 33.6 kbps</td>
</tr>
<tr>
<td>Resolution</td>
<td>Monochrome:</td>
</tr>
<tr>
<td></td>
<td>Standard: 203 pixels per inch × 98 lines per inch</td>
</tr>
<tr>
<td></td>
<td>Fine: 203 pixels per inch × 196 lines per inch</td>
</tr>
<tr>
<td></td>
<td>Photo: 203 pixels per inch × 196 lines per inch</td>
</tr>
<tr>
<td>Color</td>
<td>200 × 200 dpi</td>
</tr>
<tr>
<td>Page memory</td>
<td>Up to 100 pages (ITU-T No. 1 chart in monochrome draft mode)</td>
</tr>
<tr>
<td>Redial</td>
<td>2 times (with 1 minute intervals); specifications may differ by country or region</td>
</tr>
<tr>
<td>Interface</td>
<td>RJ-11 Phone Line</td>
</tr>
<tr>
<td></td>
<td>RJ-11 Telephone set connection</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications

Ink Cartridge Specifications

Note: This printer is designed for use with Epson cartridges only, not third-party cartridges or ink. Other brands of ink supplies are not compatible and, if described as compatible, may not function properly or continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank cartridge-free printers.

The included initial cartridges are designed for reliable printer setup and cannot be used as replacement cartridges or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711 in default mode, printing continuously. Yields vary due to print images, settings, and temperatures. Printing infrequently or primarily with one color reduces yields. All cartridges must be installed with ink for printing and printer maintenance. For print quality, some ink remains in replaced cartridges.
**Color**
Cyan, Magenta, Yellow, Black

**Cartridge life**
Opened package: 6 months
Unopened package: do not use if the date on the package has expired

**Temperature**
Storage: –22 to 104 °F (–30 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

**Dimension Specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Stored</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Height</strong></td>
<td>8.6 inches (218 mm)</td>
<td>9.5 inches (242 mm)</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>14.8 inches (375 mm)</td>
<td>14.8 inches (375 mm)</td>
</tr>
<tr>
<td><strong>Depth</strong></td>
<td>11.8 inches (300 mm)</td>
<td>22.8 inches (578 mm)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>11.5 lb (5.2 kg)</td>
<td></td>
</tr>
</tbody>
</table>

(without ink cartridges and power cord)

**Parent topic:** Technical Specifications

**Related references**

Ink Cartridge and Maintenance Box Part Numbers

**Electrical Specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply voltage</td>
<td>100 to 120 V</td>
</tr>
</tbody>
</table>
Rated frequency range 50 to 60 Hz  
Rated current 0.4 to 0.2 A  
Power consumption  
  - Standalone copying: Approximately 12 W (ISO/IEC24712)  
  - Ready mode: Approximately 4.6 W  
  - Sleep mode: Approximately 0.7 W  
  - Power off mode: Approximately 0.2 W  

Parent topic: Technical Specifications

Environmental Specifications

Temperature  
  - Operating: 50 to 95 °F (10 to 35 °C)  
  - Storage: −4 to 104 °F (−20 to 40 °C)  
  - 1 month at 104 °F (40 °C)  
Humidity  
  - Operating: 20 to 80% RH  
  - (without condensation) Storage: 5 to 85% RH  

Parent topic: Technical Specifications

Interface Specifications

Interface type Hi-Speed USB for computer  

Parent topic: Technical Specifications

Network Interface Specifications

Wireless LAN standard IEEE 802.11 b/g/n  
Wireless security WPA-PSK (AES); WPA2 compliant  
  - WEP (64/128 bit)  
Frequency range 2.4 GHz
Maximum Radio-Frequency Power Transmitted

- 20 dBm (EIRP)

Communication mode

- Infrastructure mode
- Wi-Fi Direct (Simple AP); not supported on IEEE 802.11b

Security Protocol

- SSL/TLS
- HTTPS Server/Client, IPPS

**Note:** Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location.

**Parent topic:** Technical Specifications

### Safety and Approvals Specifications

**United States**

- Safety: UL60950-1
- EMC: FCC part 15 Subpart B class B

**Canada**

- Safety: CAN/CSA C22.2 No. 60950-1
- EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:

- Manufacturer: Seiko Epson Corporation.
- Type: J26H006

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Parent topic: Technical Specifications
Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
Important Privacy Notice (Printer Serial Number)
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions
Ink Cartridge Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions

Parent topic: Notices

General Product Safety Instructions

• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

• Allow space behind the product for the cables, and space above the product so that you can fully raise the document cover.

• Leave enough space in front of the product for the paper to be fully ejected.

• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

• Do not place or store the product outdoors.

• Do not place the product near excessive heat sources or in direct sunlight.

• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.

• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

• Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your product's radio waves from affecting the operation of the pacemaker.

• When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

• Do not touch the flat white cable inside the product.

• Do not move the print head by hand; this may damage the product.

• Do not spill liquid on the product or use the product with wet hands.

• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.
• Do not press too hard on the document table when placing originals.
• Do not press too hard on the scanner glass when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any other functions.
• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the product from printing.
• Before transporting the product, make sure that the print head is in the home (far right) position and the ink cartridges are in place.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise, ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the cartridge; this can cause leakage.
• Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to become unusable.
• Do not break the hooks on the side of the cartridge when removing it from the packaging.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
• Store ink cartridges with their bottoms down. Do not store cartridges upside down.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.
• Do not subject your product to sudden changes in temperature or humidity; this may cause condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions
Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk of fire, electric shock, and personal injury, including the following:

• Do not use the Epson product near water.
• Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.
• Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions

Important Privacy Notice (Printer Serial Number)

As part of setup, your product's serial number will be sent to a secure Epson server so that you can be eligible to participate in programs we may offer from time to time, including the Epson ink replenishment program. You will have a separate opportunity to consent to participating in such programs.

If you have any questions concerning this process, you can contact us by using the Privacy Feedback Form, or you can write to:

Epson America, Inc.
Attn: Privacy Coordinator
3840 Kilroy Airport Way
Long Beach, CA 90806-2469

Parent topic: Notices

FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.
A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company. For products approved after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. But if advance notice isn't practical, the telephone company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of the equipment. If this happens the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this equipment to a telephone line, please contact:
Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment may not be used on coin service provided by the telephone company. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering fax header information.

According to the FCC’s electrical safety advisory, we recommend that you may install an AC surge arrester in the AC outlet to which this equipment is connected. Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**For Canadian Users**

1. This product meets the applicable Innovation, Science and Economic Development Canada technical specifications.
2. The Ringer Equivalence Number indicates the maximum number of devices allowed to be connected to a telephone interface. The termination of an interface may consist of any combination of devices subject only to the requirement that the sum of the RENs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)

Le présent produit est conforme aux spécifications techniques applicables d’Innovation, Sciences et Développement économique Canada.

L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une combinaison quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs n’excède pas cinq.

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Related tasks
Using the Fax Setup Wizard

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.

Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court's jurisdiction and is pending only in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling 1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

**Trademarks**

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™ is a trademark of Seiko Epson Corporation.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

Google® is a registered trademark and Android™, Chromebook™, Gmail™, Google Chrome™, Google Cloud Print™, Google Drive™, and Google Play™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2019 Epson America, Inc.
3/19
CPD-56950

Parent topic: Copyright Notice